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1

Introduction

1.1

Lite versus Full

Review software comes in two versions called ‘Lite’ and ‘Full’. The ‘Lite’ version is included, free of charge, on the
CD supplied with the instrument. The ‘Full’ version is a chargeable option.
These Help pages describe the ‘Full’ version, and thus describe a number of features which are not available, on a
continuous basis, to the ‘Lite’ user. The features of the ‘Full’ version can be enabled, in ‘demo.’ mode, from the
‘Lite’ version, either at start up or from the Options menu (Enable Review Full (Demo)). In both cases, the ‘Full’
version is available for use for only 10 minutes, after which it times out, leaving only the ‘Lite’ features available.
Features available only in ‘Full’ mode are:
Automatic Printing
Auto Archive
Chart + Replay
Running Review as a Service
Spreadsheet viewing
Security Manager support
Note: Security Manager support is not available in ‘Demo’ mode.

1.2

Effectivity

Issue 14 of this manual describes the ‘Full’ version of Review Help, at Software version 4.0 which makes it
compatible with Windows 7 operating system.
Serial communications is not supported by version 4. The .pkd file format is supported.
Windows 2000 is no longer supported in line with Microsoft dropping support as of July 2010.
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Basic Concepts

1.3

The Review Software package allows the display and printing of archive data files from suitable recorders, data
acquisition units, etc.
Data is transferred from the Archive files to a database on the PC using the ‘Transfer Files ’ item of the File menu.
Data is stored in the database, by instrument tag, descriptor, group name and point identifier.
See also ‘Log Group contents restrictions ’
Note:
The word ‘point’ is used as a general term for input channels, maths channels, totalisers, counters and so
on.
Instrument tag

Automatically retrieved from the archive file for some instruments. For other models, the tag
must be entered manually when the data is transferred to the database.

Group name

The group name (or log group name according to instrument type) is retrieved from the
archive file.

Point identifier

This item is automatically assembled from the point’s tag, descriptor, type and number.

Data from multiple archive files from the same group and the same instrument are stored together on the
database, so that data can be viewed across files.
Batch names may be associated with data from individual files. The Batch Name defaults to the file name, but
may be entered manually during transfer if required.
Data is viewed and printed as though produced on a paper chart. For the purposes of Review, a ‘chart’ is a
definition of a set of points, and a variety of setup options (e.g. number of grid divisions). The chart definition is
stored in a chart group file, with the extension .CGP. Charts are created and saved using the commands in the file
menu. The selection of those points which are to appear on the chart, is made in the Setup command in the
Chart menu.
The Instrument Interface feature allows archive data to be transferred directly from a connected instrument in
the instrument File Services view.
See also ‘Backing up the database ’.
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1.4

The Chart

Data can be displayed as if printed on the chart, as described here, or (in ‘Full’ mode only), as a spreadsheet, as
described in ‘The Spreadsheet ’, below. For Review ‘Full’ users, viewing mode (Chart, Chart + Replay or
Spreadsheet) can be selected from `Current Mode ’ in the chart setup dialogue box, or by using the ‘Toggle View
Mode’ button on the toolbar (

).

When ‘Hide data from other batches/phases’ is enabled, the batch name appears in the title bar. If a specific
phase has been selected, this also appears in the title bar, separated from the batch name by a colon (i.e.
BatchName:PhaseName).
For ‘Lite ’ users, Spreadsheet View and Chart + Replay are not available; the Current Mode selection box does not
appear in the chart setup dialogue box, and the ‘Toggle View mode’ button is ‘greyed out’.

1.4.1 Standard Charts
The figure below shows a standard static chart. The left- and right-hand Date/Time windows show the time range
across the width of the chart. This can be expanded or contracted using the ‘Time scale ’ scroll bar to the left of
the chart. The centre window shows the cursor time and date. The ‘Time select ’ scroll bar at the bottom edge of
the chart, allows the user to display a particular period of history. See also ‘Time-per-pixel ’ and ‘Faceplates ’

HA027962NLG
Issue 15 Dec 16

Page 3

REVIEW HELP MANUAL (VERSION 4.7.0)

1.4.2 Chart + replay
Select Chart + Replay in the Chart Setup dialog box. For ‘Full ’ users only, the dynamic replay feature allows the
user to review the entire history in the database, or to start running from a specific point. The replay speed and
therefore the amount of history across the page can be set by using the left hand scroll bar or by using the
‘Sample interval’ edit box (see ‘time-per-pixel ’). The start time/date is set using the horizontal scroll bar below
the chart. (This scroll bar is accessible only when replay is stopped or complete.) ‘Chart + Replay’ is not available
to users of Review ‘Lite’.

Replay Panel
The Replay panel provides controls for starting, stopping, pausing and resetting (i.e. going back to the beginning
of) the playback.

Start Replay. Chart starts replaying; Lower scroll bar disappears. Status: Running.
Stop Replay. Chart stops replaying. Lower scroll bar appears allowing a different time/date to be selected.
Status: Stopped.
Pause Replay. Chart stops replaying, but lower scroll bar remains hidden. Status: Paused
Reset Replay. Lower scroll bar appears; playback time and date returned to the start point.
Progress bar. Gives an indication of where the current time/date lies within the stored
history. The bar is ‘empty’ (i.e. completely grey) when the selected time and date lie at the oldest point of the
history. The bar is ‘full’ (i.e completely blue) when the time and date are at the most recent point of the stored
history. The example at the beginning of this paragraph shows that the current position is about half-way through
the history.
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1.5

The Spreadsheet

Spreadsheet view is available only to users of the ‘Full ’ version of Review software.
Data can be displayed as if on a chart, as described in ‘The Chart ’, above, or as a spreadsheet, as described here.
Viewing Mode (chart or spreadsheet) can be selected from ‘Current Mode ’ in the ‘Chart setup ’ dialogue box, or
by using the ‘Toggle View Mode’ button (

) on the tool bar.

When ‘Hide data from other batches/phases’ is enabled, the batch name appears in the title bar. If a specific
phase has been selected, this also appears in the title bar, separated from the batch name by a colon (i.e.
BatchName:PhaseName).
The spreadsheet view allows process data to be viewed and printed as a spreadsheet-like table of data. The first
column shows the timestamp, the second column shows messages (if enabled in Chart setup), and subsequent
columns show the process values of the points in the chart.
If ‘Raw Data’ is enabled (in Chart Setup), the data appears at the recorded intervals. If not, a fixed time interval
for the data samples can be specified from a pull-down menu (as shown above).
Notes:
1.

The content of the spreadsheet (that is, which points are included) is defined in the ‘Chart setup ’ dialogue
box.

2.

The ‘Go To facility in the chart menu (or accessible from the tool bar (
or batch start time to be selected. See ‘GoTo... ’ for details.

3.

When a chart is printed in spreadsheet mode (see ‘Print ’ for details), the time range of spreadsheet data
will not always be the same as the time range of the equivalent chart.

4.

When View Mode is switched from Chart to Spreadsheet, or vice versa, the chart pixels-per-second and the
spreadsheet sample interval are made, as nearly as is possible, the same.

5.

When switching to spreadsheet mode, the nearest sample to the chart cursor is highlighted, and, if possible,
placed at the top of the list.

6.

If there is more data than can be displayed within the time span covered by the scroll bar, then ‘Earlier
Data’ and ‘Later Data’ buttons appear at the top and bottom if the screen respectively. These buttons
become active when the scroll bar handle is at the top or bottom of the page respectively.
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1.6

Timezone indication

This optional display indicates the timezone in which timestamps on charts, spreadsheet views and printouts are
shown.
Initially Timezone indication is not selected but can be configured by selecting the ‘Show Timezone on Chart’ tick
box in the Options/Settings dialogue box (for new charts) and in the Chart set-up dialogue box (for existing
charts).
Note: PKD format files contain no timezone information, so if this feature is enabled for pkd format files, the
timezone is shown as GMT

1.6.1 Examples
GMT + 2
This indicates that the local time is two hours ahead of GMT.
GMT – 5 DST
This indicates that local time is 5 hours behind GMT, and that Daylight Savings Time will be applied if appropriate.
Note: The appearance of ‘DST’ means only that Daylight Savings Time is applied at the appropriate time of year –
it does not (necessarily) mean that DST is active for the current chart time.

1.6.2 Timezone data location
Charts (on screen)
The timezone information is located to the right of the Date/Time windows.

Charts (printouts)
For chart printouts, the Timezone data appears adjacent to the left-hand timestamp.

Spreadsheets
Timezone data is included as a part of the column 1 header both on-screen and in the printout.
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1.7

Application Control Menu

This menu is opened by clicking on the Review icon at the left hand end of the title bar. The menu items are as
follows
Restore

This is used to return the active window to the size and position it had before being
Minimized or Maximized.
Short cuts = Click on ‘Restore’ button at the right hand end if the title bar.
or <Alt> +
<Space> + <R>.

Move

For non maximized windows only
Selecting this item causes the cursor to change into a four-headed ‘arrow’
. The active
window can then be moved incrementally using the up/down/left/right cursor keys.
Short cut = <Alt> + <Space> + <M>
Alternatively, the window can be moved by click/dragging the title bar.

Size

For non-maximized windows only.
Selecting this item causes the cursor to change into a four-headed ‘arrow’
. Operating one
of the cursor keys moves the pointer to the relevant edge of the window. The window can be
re-sized incrementally using the cursor keys, or dynamically by moving the mouse.
Operating one horizontal, then one vertical key (or vice-versa), moves the pointer to the
relevant corner of the window. The window can then be re-sized, horizontally and vertically,
incrementally using the cursor keys, or dynamically by moving the mouse.
Alternatively, the edges/corners of the window can be click/dragged to the required position.
Short cut = <Alt> + <Space> + <S>

Minimize

This command can be used to reduce the Review window to an icon.
Short cuts = Click on ‘Minimize’ button at the right hand end of title bar
<Space> + <N>.

or <Alt> +

Maximize

This command is used to enlarge the active window such that it fills the available space.
When maximized, the window cannot be moved or re-sized until the widow has been
‘Restored’ (see above).
Short cut = Click on ‘Maximize’ button at the right hand end of title bar
or <Alt> +
<Space> + <X> .

Close

This command closes the active window or dialogue box.
Shortcuts:
1 = Click on ‘Close’ button at the right hand end of title bar
2 = Ctrl + F4 Closes a document window
3 = Alt + F4 Closes the application.
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1.8

Backing up the database

When Review Software is used, archive data is stored in a database on the PC. If it is important not to lose this
data, it must be backed-up on a regular basis, against loss through hardware or software failure.
The file to be saved is REVIEW.ERV in the Review Installation Directory.
Note: The original sources of the data are the .uhh or .pkd archive files from the recorder or data acquisition
unit, and it may be more important to ensure that these are stored securely. If the Automatic Backup and
Transfer facility is used, this stores the source files to the specified folder on the pc or on a server. The
files can then be backed up to a secure location to ensure that the historical data is not lost.

1.9

Database Selection

It is possible for the user to move the database (review.erv) out of its installed location, to re-name it or to have
several different databases from which charts can be generated. In addition, multiple users on different PCs can
access the same database.
To select a particular database for use, it is necessary to create a new shortcut to Review. To do this:
Operate the ‘Windows’ key (between <Ctrl> and <Alt>) and <E> to open Windows Explorer.
Locate Review.exe in the installation folder (usually C\Program Files….\Review etc.)
Right click on Review.exe, and select ‘Create Shortcut’. The shortcut appears at the bottom of the list.
Click-drag the shortcut onto the desktop and rename it if desired.
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1.9 DATABASE SELECTION (Cont.)
Once the shortcut has been created:
Right click on the shortcut and select ‘Properties’
Click on the ‘Shortcut’ tab.
In the Target window, click at the right-hand end of the line (after ‘\Review.exe’) and type: <space bar>"file
location.erv".
Example: "C:\Program Files\Recorders\Review\Review.exe" "C:\ProgramData\Recorders\Review\data.erv".
The above procedure allows the selected database to be accessed, but does not define it as the default database
(see ‘file menu\database ’). To define the selected database as the default database, <space bar>/d can be
inserted before the .erv file pathname, for example: "C:\Program Files\Recorders\Review\Review.exe" /d "C:\
ProgramData\Recorders\Review\data.erv".
If the database is on a network server, the \\server\ notation may be used.
Examples:
"C:\Program Files\Recorders\Review\Review.exe" \\server\review\review.erv.
"C:\Program Files\Recorders\Review\Review.exe" /d \\server\review\review.erv.
In all cases, the filename must have the extension .erv.
Note: The file paths listed above are for Windows 7 users. For Windows XP the paths will be of the format
C:\Documents and Settings\All Users\Application Data\Recorders\Review\....

1.10 Database too big
For Review versions prior to 3.4, the maximum database size was 1GigaByte (GB). Using the latest Microsoft
database drivers (DAO 3.6) the maximum size is increased to 2GB for Review version 3.4 onwards.
This applies only to new databases, as existing (DAO 3.5) databases cannot be upgraded satisfactorily. Review
continues to support earlier databases, but the 1GB constrain still applies.
For DAO 3.6 compatible databases, the enhanced database maintenance facilities (file menu) associated with
versions 3.4 onwards, allow data to be archived from existing databases in a number of convenient ways, thus
creating space within the existing database for later data, without the need to delete older data.
Note: For the purposes of this document, DAO 3.5 databases are referred to as ‘Old format databases’, and DAO
3.6 databases are referred to as ‘New Format databases’.

1.10.1 Warning message
When a large amount of data has been transferred into the Review database, the database may grow to an
unmanageable size. Should the database reach approximately 1950 MegaByte (MB), a warning message (below)
appears if further attempts are made to transfer files. A similar message is sent to the Communications log.
If the database is allowed to reach 2GB it may not be possible to use the software.
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1.11 Database size reduction
There are a number of ways of reducing the size of the database, described fully under ‘Maintain Database ’
found in the ‘Database’ item in the File menu.
Briefly:
For 2GB databases only, data can be moved out of the current database either to an existing database, or to a
new database.
Data can be deleted from the database. This course of action is appropriate if some of the data is no longer
required, or if backup copies of the .uhh or .pkd files have been securely archived. In the latter case, the data can
be re-imported as needed.
The existing database can be archived, and a new database created to be used as the default.
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2

File menu

2.1

File menu commands

Standard File menu
New chart

Creates a new chart.

Open chart

Opens an existing (i.e. previously created chart).

Close chart

Closes an open chart

Save chart

Saves an opened chart, using its existing name.

Save chart As...

Saves an open chart to a new, user-entered, filename.

Transfer

Transfers archive files from instruments to the PC database

Automatic print

For ‘Full’ version users only, automatically prints batch charts when a ‘Batch Stop’ is detected.

Database

Allows data from the database to be deleted or moved, new databases to be created etc.

Export

Exports data to a file, or to another application, via the clipboard.

Print

Prints a document, according to user setup

Exit

Quits Review

Delete

If the instrument interface feature is enabled, deletes files from an instrument disk.

Copy to

Copies files from an instrument disk to the desktop

Copy From...

If the instrument interface feature is enabled, copies files from the Desktop to an instrument
disk.

Save...

If the instrument interface feature is enabled, saves an instrument’s configuration to a file on
the instrument disk.

Load...

If the instrument interface feature is enabled, loads (reads) an instrument’s configuration
from a file on the instrument disk.

Properties

Displays the properties of an instrument or selected instrument file.
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2.2

New Chart

This file menu command is used to create a new chart.
New chart selection automatically activates the Chart Setup Dialogue box.
Short cuts:
1 Ctrl + N
2

toolbar button

To open an existing chart, the Open Chart command can be used.

2.2.1 Chart setup dialogue box

This dialogue box is accessed via ‘Setup’ in the ‘Chart ’ menu, or opens automatically if ‘New Chart ’ is selected.
The box is used to specify chart parameters such as which points are to be included, the number of chart
divisions, whether chart messages are to be displayed etc. Defaults can be set using the Options menu ‘Settings ’
item.
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2.2.1 CHART SETUP DIALOGUE BOX (Cont.)
Points Included
When the Chart setup dialogue box opens, a list of those points currently included in the chart is displayed. For
each point, the following information appears:
Point ID

This is a unique identifier consisting of a tag and / or descriptor (as set up in the instrument)
along with a point type and number. For the first visible point in the example, the tag is
empty, the descriptor is ‘F1 T/C4’; the point type is analogue input (ANIN), and it is the fourth
analogue input in the instrument (ANIN4).
For some LIN instruments, data points are identified by Descriptor, block and field names
rather than descriptor and point number. The default identifier for such points is of the form
Descriptor (Block:Field) e.g. Boiler Temp (TRC0101:PV) or Descriptor (Block:Field:Subfield) e.g.
IO Test Mode (T2550_C6:IO_mode:EnaTest), as appropriate.
If adaptive recording is enabled, two channel-type identifiers appear, for example:
(ANIN10)Mx and (ANIN10)Mn, which represent the maximum and minimum traces
respectively. Neither, either or both traces can be selected to appear on the chart. If both
are selected, two faceplates appear for the channel, one showing the maximum value; the
other the minimum value.

Log group

The name of the group from the original archive file.

Instrument

The instrument name.

Adding points
Points are added to the chart by clicking on ‘Add point...’, then, in the list that appears, clicking on the point to be
added. The point is added to the end of the list.
Note: The maximum number of points which can be included in a chart is 60.
Deleting points
A point is deleted from the list by clicking on the point, then clicking ‘Delete Point’
Editing points
A point may be edited (i.e. that line on the chart may be changed to a different point) by clicking on the point ID,
then clicking on ‘Edit Point...’ and selecting the required instrument log group and new point ID. The edit is made
when OK is clicked.

HA027962NLG
Issue 15 Dec 16

Page 13

REVIEW HELP MANUAL (VERSION 4.7.0)

2.2.2 Point Properties
The properties of the point (colour, span, zone etc.) can be modified by clicking on the point ID, the clicking
‘Point Properties...’. This opens the ‘Point Properties ’ dialogue box.
Point Properties Dialogue box

This dialogue box can be selected from the Chart setup dialogue box, or by clicking on the relevant Faceplate.
The box allows a number of display parameters, for the selected point, to be modified for this particular chart.
The database values are not affected. Default settings for many of these parameters may be set in the Options
menu ‘Settings ’ item
Descriptor

The selected point’s descriptor appears here, but is not editable.

Span settings

Span low and span high specify the range, in engineering units, to which the selected trace will
be scaled. Span low can be higher than span high, in which case the scale is reversed.
For those instruments which allow span A and span B, these values represent the span A
values. See ‘Advanced Properties ’ for Span B

Zone settings

Zone low and zone high specify the area of the chart to be used to display the selected trace.
For example, settings of 50% and 100% cause the trace to appear in the top half of the chart.
For those instruments which allow zone A and zone B, these values represent the zone A
value. See ‘Advanced Properties ’ for zone B.

Scale Type

Allows the scale type to be chosen for the selected point.
Linear:

Values are displayed without conversion. The Y-axis scale is linear from
Scale Low to Scale High.

Logarithmic:

Review takes the log of the input values. The Y-axis scale is logarithmic
from log10(Scale Low) to log10(Scale High).

Logarithmic/Linear: Review assumes that the input values are already logarithmic (as with
some transducer types). The Y-axis scale is logarithmic from log10(Scale
Low) to log10(Scale High).
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2.2.2 POINT PROPERTIES (Cont.)
Trace Mode

Normal mode, Interpolation off.
The value displayed is that of the sample immediately prior to the time shown on the chart.
Normal mode, Interpolation on.
As above, but if the chart is displayed at a resolution higher than that of the data, the value
shown is determined by interpolation between samples. The letter ‘I’ is appended to the point
descriptor.
Average mode, Interpolation off.
If the database contains multiple values for a pixel, the displayed value is determined by
taking the average value of all the samples covered by that pixel. The letters ‘Av’ are
appended to the point descriptor.
Average mode, interpolation on.
As for Average mode, interpolation off, but if the chart is displayed at a resolution than that
of the data, then the displayed value is determined by interpolating between the average
values of adjacent pixels. The letters ‘AvI’ are appended to the point descriptor.
Minimum mode, interpolation off.
As for normal mode, but if the database contains multiple values for a pixel, the minimum
value is displayed. Interpolation is not available for minimum mode. The letters ‘Mn’ are
appended to the point descriptor.
Maximum mode, interpolation off
As for normal mode, but if the database contains multiple values for a pixel, the maximum
value is displayed. Interpolation is not available for maximum mode. The letters ‘Mx’ are
appended to the point descriptor.

Colour

Allows the user to select the trace colour for the point. For those instruments which support
colour A and colour B, this value represent colour A. See ‘Advanced properties ’ for colour B.

Notes:
1

When a chart is compressed, the cursor time shown for a pixel is the latest time covered by that pixel. For
example, when averaging, the averaged value is for the period immediately prior to the displayed time. See
‘The Chart ’ for Time scale selection.

2.

If Average, Minimum or Maximum modes are selected, and a large compression factor is selected for the
chart, then the chart re-draw time may be extensive, since all the samples in the displayed time span must
be interrogated. See ‘The Chart ’ for Time scale selection.

3.

If a point appears on the chart a number of times (for example, once in minimum mode and once in
maximum mode), multiple trend lines for that point will appear. These can be configured with different
colours etc., as described above.
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2.2.2 POINT PROPERTIES (Cont.)
Advanced Properties

The Advance properties key allows the following actions for instruments which support A/B settings:
Span B low entry
Span B high entry
Zone B low entry
Zone B high entry
Trace Colour B entry
Scale-type selection for B traces.
‘A’ settings are carried out in the Point Properties dialogue box, above.

2.2.3 Current Mode

This configuration area appears only for users of Review ‘Full’.
Current mode allows the user to define the display mode as Chart, Chart + Replay or Spreadsheet. The Print
mode is independent of this setting, and is set up in the Print Setup page. The default for new charts can be set
in the Options menu ‘Settings ’ item. For Review ‘Lite’ users, Spreadsheet view is not available, and the Chart +
Replay selection box is located in the ‘Chart Setup ’ area.
Current view mode can also be toggled between Chart and Spreadsheet, using the Toggle View Mode tool bar
button (
). This button is ‘greyed’ for ‘Lite’ version users. If Chart + Replay is selected, the View is switched
to spreadsheet and back again, normal Chart Mode will be returned to.
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2.2.3 CURRENT MODE (Cont.)
Chart view provides a chart display as described in ‘The Chart ’, above. The Chart setup area of the Chart setup
dialogue box allows message display to be enabled/disabled, and the chart grid to be defined.
Chart + Replay also provides a chart display, but with controls to start, stop, pause and reset the replay facility.
Initially, the start position for replay is at the oldest data on the chart, but the start position can be adjusted using
the horizontal slider beneath the chart. See ‘The Chart ’ for further details.
Spreadsheet view allows process data to be viewed (and printed if required) as a spreadsheet-like table of data,
with columns for Timestamp, Messages (if enabled – see Spreadsheet setup, below) and process values for each
point in the chart.

2.2.4 Chart Setup

This area of the Chart Setup dialogue box contains the following configurable items.
Show Messages
Enabling (‘checking’) this box causes any relevant messages to appear on the chart.
Keep traces clear of timestamps
If this is enabled, timestamps are moved to a position immediately above the chart so they do not obscure the
traces.
Grid Major Divisions/ Grid Minor Divisions
These two boxes allow the number of vertical divisions on the chart to be defined. In each case, the number
entered is the number of divisions from low scale to high scale.
Minor divisions are separated by thin lines, major divisions by slightly thicker lines.
For example, if ‘Grid Major Divisions’ is set to ‘5’, and ‘Grid Minor Divisions’ is set to ‘20’, then 21 horizontal thin
lines are drawn (including scale 0% and 100%), every fourth one of which is overlaid by a slightly thicker line.
GRID MINOR DIVISIONS
The total number of chart divisions in the vertical (point value) axis, to be drawn with (i.e. separated by) thin lines.
GRID MAJOR DIVISIONS
The total number of chart divisions in the vertical (point value) axis, to be drawn with (i.e. separated by) thicker
lines.

2.2.5 Show Timezone on Chart
This configuration item is a part of the Chart Setup dialogue box.

If enabled, this causes timezone information to appear in chart, spreadsheets and printouts. For more details, see
Timezone Indication.
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2.2.6 Spreadsheet Setup
This display ‘box’ appears as a part of the Chart Setup dialogue box for ‘Full ’ version users only.

Values

When selected, this causes Process Values to be included in the spreadsheet.

Messages

When selected, this causes any relevant messages to be included in the spreadsheet.

Raw Data

When selected, this causes Raw Data to be included in the spread sheet.
Raw data is data, as recorded (i.e. at whatever interval the relevant recording device is or was
using). If ‘Raw Data’ is not selected, then the user can specify a fixed interval between values,
and thus define how many readings are to appear within any particular time period.
The interval is chosen from a ‘drop-down’ menu which appears in the toolbar, as shown in
‘The spreadsheet ’, above.

Use Report Font in Spreadsheet View
When ticked, the font selected as ‘Report Font…’ in the Options/fonts menu is used for this spreadsheet.
The normal default state of this tick box is ‘unticked’. This default status can be changed to ‘ticked’, in the
Options/Settings menu. In this case, all new charts automatically use the Report Font, unless the selection box for
this particular chart is ‘unticked’ here in Spreadsheet Setup.
If ‘unticked’ the system default (as determined by Windows) is used.

Page 18

HA027962NLG
Issue 15 Dec 16

REVIEW HELP MANUAL (VERSION 4.7.0)

2.2.7 Auto Zone
This allows ‘Adjacent’ or ‘Overlaid’ to be selected for chart traces. The default can be set in Options/Settings.

Selecting ‘Zones Adjacent’ causes the chart traces to be separated from one another. Scales are adjusted to fit.
Traces appear approximately adjacent to their faceplates.

Zones Adjacent
‘Overlaid’ presents the traces as zoned at the instrument or in the point properties dialogue box.

Zones Overlaid
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2.3

Open Chart

Accessed via the File menu, or by using one of the short cuts listed below, this command is used to open an
existing chart, in a new window. (To create a new chart, the New Chart command is used, as described above)
Short cuts:
1. Ctrl + O
2.

toolbar button

3. Near the bottom of the file menu is a list of recently opened charts. Clicking on one of these will open that
chart.
If multiple charts are open at the same time, the Window menu can be used to select the active window.

2.3.1 Open Chart dialogue box
This appears when the Open Chart command is executed, and allows the user to specify the exact name of the
file to be opened.

2.4

Close Chart

Accessed via the file menu, or by using one of the shortcuts listed below, this command is used to close all
windows containing the current chart.
If an existing chart has changed, an opportunity is given to save the changes. For all charts, the ‘Save Chart As... ’
dialogue box appears allowing the chart to be renamed.
Short cuts:
1.

icon

2. Ctrl + F4

2.5

Save Chart

This command, accessed from the file menu, or by using one of the shortcuts below, causes the active chart to be
saved to its current name and directory. If this is a new chart, which has not yet been named, the `Save Chart
As... ’ dialogue box appears, allowing the chart name and its directory to be specified.
Short Cuts;
1.

tool bar button

2

Ctrl + S

Note:
Existing charts can be renamed using the ‘Save Chart As... ’ command.
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2.6

Save Chart As...

This command, accessed from the file menu, causes the ‘Save As’ dialogue box to appear. This dialogue box
allows a chart to be renamed, and its destination folder to be defined as necessary.
Review enters the extension in the ‘Save as type:’ window.

2.7

Transfer

Clicking on ‘Transfer’ causes a sub menu to appear which allows the user to choose ‘Files ’, ‘From Folders ’, ‘From
Removable Media ’ or Scheduled Transfer.
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2.7.1 Transfer Files
This file menu command causes the transfer of selected files from the instrument to the PC database. Transfer is
initiated from the Transfer files dialogue box. If no files are currently selected, the command first brings up a
standard ‘Open Files’ dialogue box, to allow the required files to be selected from the database.

Once the selection has been made, the Transfer Files Dialogue box is activated:

An initial scan is performed on the file to check data validity.
If valid, configuration data is first extracted and stored in the database. Process data is then similarly extracted
and stored in the database.
If not valid, the user may be given the opportunity to transfer some of the data, depending on the error.
The ‘Abort’ key allows the transfer process to be stopped. Data already transferred is not lost, and the transfer
may subsequently be completed, by selecting the file for transfer again.
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2.7.2 Transfer From Folders

Similar to ‘Files ’, above, this allows all new or modified files, from a specified folder, to be transferred. The
Source Archive folder may be a temporary folder into which the archive files have been copied, or it may be a
folder on a server, as, for example, when ‘Archive via FTP’ is in use (not supported by all models).
Source files are copied to a subfolder within the Master Archive Folder. The location of the Master Archive
Folder can be defined using the Options Menu ‘Master Archive Folder’ item. The Master Archive Folder contains
one subfolder for each instrument, and the name of each subfolder is the same as the tag of the instrument to
which it relates. This naming strategy is the same strategy as is used for backup and transfer operations.
Notes:
1

The archive files in the Master Archive Folder must be retained.

2

For some instruments, the file names created are not unique. This means that folder may contain new files
that have the same names as older files, previously transferred. In such a case, the new files are given new
names as they are copied to their sub-folder within the Master Archive Folder. These new file names are
created by appending a two or more digit number to the original file names.

Master Archive Folder
This options menu item allows the Master Archive Folder location to be defined, for use with the File menu
Transfer command.

If a database is being shared amongst computers, then the specification of the Master Archive Folder must be a
UNC path of the format:
\\server name\share name\path\folder name
If it is not in this format, a warning appears each time the Master Archive Folder name is configured to be
anything other than the default.
Using this format ensures that all computers copy files to the same master folder, and not to local folders in each
computer.
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2.7.3 Transfer from Removable Media

This allows new or modified files to be transferred from a floppy disk or PC card to the Master Archive Folder.
The location of this folder can be defined using the Options menu ‘Master Archive Folder’ item.
Source files are copied to a subfolder within the Master Archive Folder. This folder contains one subfolder for
each instrument, and the name of each subfolder is the same as the tag of the instrument to which it relates.
This naming strategy is the same strategy as is used for backup and transfer operations.
Notes:
1

The archive files in the Master Archive Folder must be retained.

2.

For some instruments, the file names created are not unique. This means that a disk or PC Card may
contain new files that have the same names as older files, previously transferred. In such a case, the new
files are given new names as they are copied to their sub-folder within the Master Archive Folder. These
new file names are created by appending a two or more digit number to the original file names.

Delete source files after copying to master folder
When enabled, this checkbox instructs the software to delete files from the floppy disk or PC card, once they
have been copied to the Master Archive Folder and transferred to the data base. This prevents the retention of
old files on disk or PC card, thus improving the efficiency of the recording and transfer operation.
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2.7.4 Scheduled Transfer
Available only to users of Review Full.
This Transfer menu item provides the ability to set up a schedule whereby any new .uhh files found in a specified
folder or subfolder are transferred in the same way as Transfer ‘From Folders ’ described above, but
automatically, at a specified periodicity. A typical application would be to transfer files from a folder which has
been set up to receive regular archive files, sent to the PC by a chart recorder via an FTP server. If ‘Run as a
Service ’ is enabled, it is also possible to convert .uhh files to comma-separated-variable (CSV) format files, and to
define a destination folder for them. The format of the CSV files is defined in ‘Settings ’ in the Options menu
Clicking on the item calls the set-up page:

Run as a Service

See ‘Running Review as a Service ’, section 0, for details of the ‘Run as a Service’
checkbox. It should be noted that ‘Run as a Service’ can also be
enabled/disabled in the Autobackup + Transfer box. If enabled in one, it is
enabled in the other, and vice-versa.

Source Archive Folder

Allows a source folder for the required files to be browsed for or typed in.

DATABASE TRANSFER
If enabled, this allows the transfer of the files from the Source Archive folder to the database to be carried out
automatically, using the criteria defined in the AUTOMATE area.
EXPORT TO CSV FILE
Enabled

This tickbox is greyed out unless ‘Run as a Service’ is enabled.

Destination

Allows a destination path to be defined for CSV files.
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2.7.4 SCHEDULED TRANSFER (Cont.)
AUTOMATE
Next run:

This allows the user to specify an initial day number and time for the first transfer to take
place. This value is automatically updated after each transfer, according to the setting in the
‘Repeat every’ window below. For the settings in the example above, scheduled transfers
would occur every day at 1 a.m., starting on the 15th of the month.

Repeat every:

This allows the user to select a repeat period for Scheduled Transfer, starting from the
specified time and day number entered in the ‘Next Run’ window, above. The period is
selected from a picklist of 5, 15 or 30 mins; 1, 2, 8 or 12 hours; every day; every week; every
month, or, if ‘0’ is selected, Scheduled Transfer is inhibited. See ‘Note’, below

Also run immediately new file detected
Clicking on this box causes Review software to check the instrument, every minute, for new
files. If a new file is detected (see ‘Note’ below), a transfer operation is carried out
immediately, no matter what the automatic repeat rate setting.
This feature can be particularly useful in combination with the Automatic Print feature. For
example, if the instrument is configured to ‘Name files by Batch’, then, when a batch finishes,
the current file is closed and a new one opened. This initiates a Scheduled Transfer operation,
and activates automatic printing.
Note: If ‘0’ is selected in ‘Repeat every:’, and ‘Also run immediately new file detected’ is enabled, then a transfer
occurs only when a file is closed and a new one opened, and only the closed file(s) are transferred. This
means that each file will be transferred (and CSV files generated) only once. If a ‘Repeat every:’ value
other than ‘0’ is selected and ‘Also run immediately…’ is enabled, then the scheduled transfer causes all files
(including open ones) to be transferred, but intermediate transfers, triggered by new file detection, transfer
only closed files.

2.7.5 Preparing files for transfer
If a single file is selected, it is automatically interrogated and the log group, start time and a batch name are
displayed, along with an instrument tag (if one exists in the file). If the file does not contain an instrument tag,
one must be entered either by typing the tag, or by selecting it from the picklist.
If the recorder supports batch operations, then batch names are determined by the data in the file. Otherwise, an
appropriate string may be entered manually, or the field may be ignored.
If multiple files are selected, then the user will be prompted either to enter an Instrument Tag and Batch Name
for each selected file, or to allow the software to determine Instrument Tag and Batch Name automatically. In
the latter case, if the first file is from an instrument for which no instrument tag has been configured (i.e. the
instrument tag is still the default tag), then the user must select or enter an instrument tag to be used.

Page 26

HA027962NLG
Issue 15 Dec 16

REVIEW HELP MANUAL (VERSION 4.7.0)

2.7.6 File Transfer

Once all the files have been prepared (see ‘Preparing Files for Transfer ’, above), clicking on the ‘Start Transfer’
button in the Transfer Files dialogue box initiates the transfer.
An initial scan is performed on each file to check data validity.
If valid, configuration data is first extracted and stored in the database. Process data is then similarly extracted
and stored in the database.
If not valid, the user may be given the opportunity to transfer some of the data, depending on the error.
The ‘Abort’ key allows the transfer process to be stopped. Data already transferred is not lost, and the transfer
may subsequently be completed, by selecting the file for transfer again.

2.7.7 Redundant Instrument files
This topic applies to the situation where two processors (primary and secondary) are running in parallel, such that
one can take over from the other in case of failure.
Data Transfer
Review holds a single set of data for a redundant instrument. Where samples are imported from a primary and a
secondary for any period, then only the primary data is retained.
Some Messages are unique to the secondary system, and such messages are preceded by a superscript 2 to
identify them. An example of such a chart message is shown below, rotated 90 degrees for convenience.

Sample data is identical for the primary and secondary processors except in the following cases, both of which
can arise only if adaptive recording is enabled.
1. The first sample after synchronization
2. If either processor loses a sample and therefore records a different time period (and therefore a different
value). Such data loss is usually caused because an attempt has been made to record more data than can be
accommodated by the instrument in the available time. This gives rise to a Lost Data alarm in the RGROUP
block.
See the ‘Recorder’ section of the LIN blocks reference manual (HA082375U003), for more details of the
RGROUP block.
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2.8

Automatic print

This feature is available only to users of the ‘Full ’ version of Review. For ‘Lite ’ version users, ‘Automatic Print’ is
‘greyed’ in the File menu.
The feature is particularly useful in combination with Auto Backup + Transfer, as it can be used to print charts
without operator intervention. If the relevant software is available, pdf versions of the charts can be produced,
for cross-platform compatibility.
When data is transferred from a recorder or data acquisition unit which supports batch operations, and an ‘End of
Batch’ is detected, the list is examined. If any of the lines matches the Instrument and Group in the transferred
data, a copy of the chart is printed at the selected printer. It is printed either as a chart or as a message list, as
defined in the ‘Print Setup ’ page (called by clicking ‘Print’ in the file menu, or by using Ctrl + P). If multiple lines
contain the same instrument and group names, then multiple charts are printed.

Selecting ‘Automatic Print’ from the file menu causes a list of Automatic Print Specifications to appear. Each line
shows an Instrument name, a Group name, an indication as to whether Batches have been merged (X= Merged), a
Chart File name, and a printer name.

2.8.1 Add
Clicking on Add causes the ‘Print details’ dialogue box to appear, allowing the user to select a file to be added to
the print list. The details are initially empty and have to be filled, as in the example below.
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2.8.1 ADD (Cont.)
Merge batches with matching descriptors
If this tickbox is enabled, then all batches with the same name are merged and the start and end times are
determined from the earliest and latest batch records in the database.
If not enabled, then the batch start date is appended to the batch name(s) in the drop-down list.

2.8.2 Edit
This causes a box similar to the ‘Add’ box, above to appear, allowing the user to edit the details of the highlighted
file.

2.8.3 Delete
Deletes the highlighted file (without confirmation).

2.8.4 PDF copies of charts
The ‘Edit’ page also allows the printer, to which the automatic print is to be directed, to be specified. If the
relevant PDF printer software is available, the PDF Printer checkbox appears, allowing pdf printers to be selected.
Enabling this checkbox also presents two new fields, allowing the user to append a suffix to the batch name, and
to define the destination of the file by filename and path. This produces pdf copies of charts, which can easily be
exported across platforms.
Note:
No checking is carried out on the filename. If the filename already exists in the specified location, the
existing file will be overwritten.

Currently supported pdf printer drivers
The following pdf printer drivers are supported:
1.

Acrobat PDF writer (up to and including Acrobat 9.x) (See note)

2.

ITEKsoft PDF Pro (version 6.14 or above) available from www.iteksoft.com

Note: Full Acrobat required for Acrobat PDF writer, not just Acrobat Reader.

2.8.5 Print specified batch only
Selecting ‘Hide data from other batches’ in the Print Setup page ensures that only the data associated with the
specified batch is printed.
HA027962NLG
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2.9

Database

Select database

Allows the user to select an already existing database

New database

Allows the user to open a new, empty database

Set Default database
Allows the user to set the current database as the default.
Database properties
Gives details of the currently open database.
Maintain database This allows the user to delete data from the data base, or to move it to a new or pre-existing
database.
Auto archive

This allows the automatic archiving of data which is over a specifiable age at a specified
periodicity.

2.9.1 Select database
This operation can be carried out only when there are no charts on display. Clicking on this item whilst a chart is
open, will cause the user to be prompted to close all open windows before continuing.

Selecting this item opens a ‘browse window, allowing the user to navigate to the required, existing database (.erv
file).
Scheduled Transfer and Auto Backup + Transfer operations will not take place while a database other than the
default database is selected. See ‘Set Default database ’ for more details.
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2.9.2 New Database
This allows the user to define the pathname for a new (empty) database.

Selecting this item opens a ‘browse window, allowing the user to define the required path name.
Backup/transfer operations always take place with the default database, and if the new database is not the
default, it will not be updated. See ‘Set Default database ’ for more details.

2.9.3 Set Default Database
Selecting this menu item calls a dialogue box to confirm that the currently open database is to be made the
default. The default database is that used when Review is opened, and is the database used for Auto Backup +
Transfer and Scheduled Transfer operations.
The default applies to all users of the PC.
If an attempt is made to transfer data into any other database, a warning message appears.

2.9.4 Database Properties
Selecting this database menu item, calls the properties window which gives details of the current database.
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2.9.5 Maintain Database
This dialogue box is accessed from the File menu Database submenu ‘Maintain Database’ item. It is used to view
and/or remove batches in the database.

The right-hand window shows all batches held on the database for the instrument selected in the left-hand
window.
‘All instruments’ in the left-hand window (as illustrated above), causes a list of all batches in the database to
appear in the right-hand window.
Clicking on the + sign or double-clicking the ‘All Instruments’ folder reveals a list of instruments held in the
database.
Clicking on the + sign, or double clicking the associated instrument folder, produces a list of groups within that
instrument. Clicking on one of these groups causes a list of all the batches held within that group (only) to
appear in the right hand window.
Note:
If there are missing samples in an original packed data file, the data appears as multiple consecutive entries
in the list of batches.
Sorting Batches
Batches are normally sorted in end-time order, with the oldest first. Clicking on ‘Batch Name’ sorts by batch
name. Clicking on ‘Start Time’ or ‘End Time’ sorts by start time or end time respectively. Clicking a second time
on any of these headers reverses the listed order.
Selecting Batches
A single batch is selected by clicking on the batch name.
Consecutive batches can be selected by holding the shift key down, then clicking on the first and last names
required.
To select non-consecutive batches, the Ctrl key is held down whilst the required batch names are clicked on
individually.
To select all non-selected batches and, at the same time, to de-select all selected batches, the ‘Inverse’ key should
be clicked.
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2.9.5 MAINTAIN DATBASE (Cont.)
Move to Existing Archive Database
If the current and the existing databases are both of the New Format, then a ‘file open’ dialogue box appears,
allowing the user to select the required existing database that the data is to be moved to.
If the databases are not both of the New Format, an error message is displayed.
Move to New Archive Database
If the current and the working database is compatible with New Format databases, then a ‘file browse’ window
appears, allowing the user to enter the name and path of database to be created.
If the databases are not both New Format compatible, an error message is displayed.
Deleting Batches
Once one or more batches have been selected, clicking on the ‘Delete’ key causes the highlighted batch(es) to be
deleted (after confirmation).
When deleting multiple batches, in order to by-pass the appearance of an individual confirmation request window
for each batch, the ‘Yes to All’ key should be clicked in the confirmation request window for the first (or any
subsequent) batch.
Compacting the Database
After deleting one or more batches, clicking ‘Close’ causes a dialogue box to appear, asking if the database is to
be compacted. It is recommended that ‘Yes’ be clicked in order to optimise disk space usage. The process may,
however, take some time. If ‘No’ is clicked on, the dialogue box reappears each time Review is opened or closed.
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2.9.6 Auto Archive
This feature is available only to users of the ‘Full ’ version of Review.
This feature is usable only with New Format databases. A warning message appears if an attempt to use Auto
Archive is made with an Old Format database, or if such a database is made the default database whilst Auto
archive is enabled.
Auto Archive allows the user to configure Review regularly to move or delete from the default database, any data
which is over a specified age.
Examples
Every month, move data over 3 months old from the running database to a new ‘Archive’ database.
In this case, a new database is created every month. The new database is called: ‘review_yyyymmdd.erv’, where
yyyymmdd represents the date (year, month and day number) on which the database was created. Thus
‘review_20041101.erv’ would be the name given to a database created on the 1st November 2004.
Every week, delete data that is more than 1 year old from the running database.
Note:
The original .uhh or .pkd files are not deleted.
Auto Archive Dialogue box
The figure below shows typical settings for example 1, above.
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2.9.6 AUTO ARCHIVE (Cont.)
Enable Database Auto Archive
Allows the user to enable/disable auto archive.
Archive old data to new database
Causes data to be copied to a new database, before being deleted from the default database.
Mutually exclusive with ‘Delete old data from database’, below.
Delete old data from database
Data is deleted from the default database, without being saved elsewhere. The source (.uhh
or .pkd) files are not deleted. Mutually exclusive with ‘Archive old data to new database’,
above.
Archive/Delete data older than:
Allows the user to select a data age from a drop-down picklist.
Perform Archive/Delete every:
A periodicity can be selected from a drop-down pick list
Next Archive/delete due:
Allows the user to enter a time and date for the next auto archive operation. The date is
entered either by clicking on the individual segments and typing-in the required numbers, or
by using the calendar which is displayed if the down arrow button is clicked on.
The time is entered either by clicking on the individual segments and typing-in the required
numbers, or by using the scroll buttons.
Folder to store Archive Database in:
This allows the user to define the folder in which the archive databases are to be stored. The
folder path can be typed-in (e.g. \\server\archive\path) or the browse feature can be used.
The archive databases themselves are named automatically using the format:
‘review_yyyymmdd.erv’, where, yyyymmdd represents the date (year, month and day number)
on which the database was created. Thus ‘review_20050101.erv’ would be the name given to
a database created on the 1st January 2005.
Prompt User before performing Archive/Delete
If this checkbox is enabled, the user is warned that an auto archive is about to occur, with the
opportunity for the user to Cancel the operation. If the operation is cancelled, the user is
prompted again every 24 hours, and/or every time Review is started or quitted.
If Review is running as a service, no prompt is given.

2.9.7 Compacting the Database
When auto archive runs it sets a flag to indicate that data has been deleted from the data base.
If Review is running as a service, it will check this flag every minute and automatically do the compact.
If Review is running in the foreground it will check this flag when Review is closed. If the flag is set a pop-up
dialog box will be shown with the choices of Yes or No. If Yes is selected the compact process takes place. If No
is selected you will be asked again when Review is next started.

HA027962NLG
Issue 15 Dec 16

Page 35

REVIEW HELP MANUAL (VERSION 4.7.0)

2.10 Export
Clicking on ‘Export’ in the File menu, calls the Export table dialogue box. This allows the export of a table of data,
or of messages to a file or to the clipboard, for ‘pasting’ into a document or spreadsheet. Before the ‘Export’
command is activated, the current chart should be adjusted so that the data to be exported is visible. The
exported data is that on display.

2.10.1 Export Range
Current View

Exports what is currently on display in the chart window. For charts, the time range of the
exported data is defined by the difference between the left hand and right hand date/time
indicators below the chart. For spreadsheets (‘Full’ version only), the exported data is that
which appears on the display page.

Selected Range

For spreadsheets only, allows a specific range of data to be exported.

Batch

Only batches active after start of
This applies a filter to the search range, so that only those batches with a start time after
that specified are included. Applies to ‘Find Batch…’ and ‘Batch Name:’
Only batches active before end of:
This applies a filter to the search range, so that only those batches with a finish time
before that specified are included. Applies to ‘Find Batch…’ and ‘Batch Name:’.
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2.10.1 EXPORT RANGE (Cont.)
Find Batch…

Opens a browser facility to allow the user to select a batch file. If the ‘active after’ and ‘active
before’ filters have been selected, only those files within the selected range appear.

Batch Name:

Enter the batch name, or use the ‘Find Batch...’ browse facility to locate it. If the ‘active after’
and ‘active before’ filters have been selected, only those files within the selected range
appear.
Show entire batch/phase
Check this box if the whole batch or phase is to be exported, including any text messages
at the end of the batch.
Hide Data from other batches/phases
A chart can contain traces and messages from more than one batch or phase, and can
contain traces not associated with a batch at all. In such cases, it is often clearer if only
those traces associated with the required batch or batch phase are exported. This can be
achieved by selecting ‘Hide Data from other batches/phases’. This selection also removes
any pre-batch and post-batch data.

Phase

For those instruments which support batch phase, this allows a particular phase of the batch
to be selected for export. For other instruments, this window is disabled (‘greyed’).

From

Select ‘From’ if the exported data is to start at a particular date and time. The start date can
be selected by clicking on the individual date figures and editing them as required, or the
calendar can be ‘pulled down’ and the required month and day selected. The start time field
can then be edited to show the required start time, and a duration can be entered to define
the length of the data range.

Duration

If the entire range is not required, a duration can be entered using the Days, Hours, Mins and
Secs boxes. The exported data will start at the beginning of the batch and continue until the
specified duration has been reached.

2.10.2 Export What?
Values

Selecting ‘Values’ exports Process Values over the appropriate time range. Provided that ‘Raw
Data’ is not selected (below), a sample interval can be selected, as depicted in the illustration
above.

Messages

Selecting ‘Messages’ causes messages from within the appropriate time range to be exported.

Raw Data

This is the data as recorded at the sample interval defined at the relevant instrument. If ‘Raw
Data’ is selected, the sample interval field on this page no longer applies and is ‘greyed’.

Sample interval

For use when ‘Raw Data’ has not been selected, to allow the user to define the time period
between exported data samples, and thus the number of samples in the defined data range.
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2.10.3 Layout

This key allows the format of export data to be defined.
Date/Time Format
Text String

Date and time exported as a text string. Mutually exclusive with ‘Spreadsheet Numeric
Format’ described below.

Spreadsheet Numeric Format
Date and time are exported in the numeric format recommended if exporting to a
spreadsheet. Mutually exclusive with ‘Text String’ described above.
Separator
Tab

Exported values are exported as tabs. This is the format recommended if exporting to a
spreadsheet. Mutually exclusive with ‘Default Separator’, described below.

Default Separator Exported values are separated by the ‘system default separator’, which varies from pc to pc.
Mutually exclusive with ‘Tab’ above.
Include Column Headers
If this checkbox is enabled, the first line of the table consists of headers, identifying the table columns.
InSQL Format
If this checkbox is enabled, csv files are exported in InSQL format. See ‘Settings ’ in the Option Menu topic for a
description of CSV file naming conventions. When enabled, all other selections in Export table are greyed out.

2.10.4 Copy to Clipboard
This key initiates the copying of the selected data to the clipboard, ready to be pasted into a spreadsheet or other
file. Copying is complete when the dialogue box disappears.
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2.10.5 Copy to File
This calls a further dialogue box, allowing a filename to be entered for the exported data. Clicking ‘Save’ in this
dialogue box initiates the export process. the chart is redrawn when the copying process is complete.
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2.11 Print
This command is used to print a chart, message table or (for ‘Full’ version users) spreadsheets. When called from
the file menu, or by either of the shortcuts below, the Print Setup Dialogue box (below) appears.
Shortcuts:
1.

button in toolbar

2. Ctrl + P

2.11.1 Print Setup

Print Range
CURRENT VIEW
For charts, prints what is on display in the chart window, using the time span defined by the left and right-hand
date/time windows.
For Spreadsheets (‘Full’ version only), prints the data currently in the display screen.
SELECTED RANGE
This item appears only in spreadsheet mode (not available for ‘Lite’ version).
If the user has highlighted a range of data at the spreadsheet, then enabling ‘Selected Range’ causes the printout
to include only the highlighted items.
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2.11.1 PRINT SETUP (Cont.)
BATCH
Enables following fields for editing.
ONLY BATCHES ACTIVE AFTER START OF
This applies a filter to the search range, so that only those batches with a start time after that specified are
included. Applies to ‘Find Batch…’ and ‘Batch Name:’.
ONLY BATCHES ACTIVE BEFORE END OF
This applies a filter to the search range, so that only those batches with a finish time before that specified are
included. Applies to ‘Find Batch…’ and ‘Batch Name:’.
FIND BATCH…
Opens a browser facility to allow the user to select a batch file. If the ‘active after’ and ‘active before’ filters have
been selected, only those files within the selected range appear.
BATCH NAME
Enter the required batch name, or use the pull-down menu to select a batch. If the ‘active after’ and ‘active
before’ filters have been selected, only those files within the selected range appear.
PHASE
For those instruments which support batch phase, this allows a particular phase of the batch to be selected for
printing. For instruments that do not support batch phase, this window is disabled (‘greyed’).

MERGE BATCHES WITH MATCHING DESCRIPTORS
If this tickbox is enabled, all batches with the same name are merged and the start and end times are determined
from the earliest and latest batch records in the database.
If the button is not selected, then the batch start date is appended to the batch name(s) in the drop-down list.
PRINT ENTIRE BATCH/PHASE
Check this box if the whole of the selected batch or phase is to be printed, including any text messages at the end
of the batch.
HIDE DATA FROM OTHER BATCHES/PHASES
A chart can contain traces and messages from more than one batch or phase, and can contain traces that are not
associated with a batch at all. In such cases, it is often clearer if only those traces associated with the required
batch or phase are printed. This can be achieved by selecting ‘Hide data from other batches’. This selection
removes any pre-batch and post-batch data.
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2.11.1 PRINT TSETUP (Cont.)
FROM
Select ‘From’ if the printout is to start at a particular date and time. The start date can be selected by clicking on
the individual date figures, and editing them as required, or the calendar can be ‘pulled down’ and the required
month and day selected. The ‘start time’ field can be edited to show the required starting time for the printout,
and a duration can be entered to define the length of the printout.
DURATION
If an entire batch is not required, a duration can be entered, using the Days, Hours, Mins and Secs boxes. The
printout starts at the beginning of the batch, and continues until the specified duration has been reached.
Duration is also associated with the ‘From’ field, above, for non-batch printing.
Print What?

This allows ‘Chart’, ‘Message’ or (for ‘Full’ version users only) ‘Spreadsheet’ to be selected for printing in either
Portrait (tall) or Landscape (wide) format.
Chart

Click on ‘Chart’ if the printout is to be in the form of a chart.

Message Table

Click on ‘Message Table’ if the printout is to be tabular in nature. the output is a list, in two
columns, of some or all of the textual messages associated with the currently plotted data.
The table includes a timestamp as well as the text of each message.

Spreadsheet

Available for ‘Full’ version users only. Click on this button to print process data as a
spreadsheet table. As shown in the figure below, the first column contains timestamps. The
second column shows messages (if enabled in Chart setup). The remaining columns contain
the process values or status (as displayed in the relevant faceplate) of each enabled point in
the chart.

Note:
The current viewing mode (Chart or Spreadsheet) is selected in Chart setup. Current print mode (Chart,
Message Table or Spreadsheet) is selected here, in Print Setup, and is independent of the current viewing
mode.
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2.11.1 PRINT SETUP (Cont.)
Print Output
The print output depends on the above settings, and on whether the current screen view is chart or spreadsheet.
Screen View

Print Range

Print What

Result

Chart

Current View

Chart/Message table

Chart or message table for chart time
range

Spreadsheet

Spreadsheet showing entire range of data
currently visible on the chart.

Chart/Message table

Prints data as specified by Batch, From and
Duration entries.

Spreadsheet

Spreadsheet showing data currently visible
on screen.

Chart/Message table

Chart or message table for screen
spreadsheet time range.

Spreadsheet

Spreadsheet showing data currently visible
on the screen.

Chart/Message table

Chart or message table showing data from
range specified in spreadsheet.

Spreadsheet

Spreadsheet showing data from time range
selected in spreadsheet. Valid only if a
contiguous range of rows is selected. If
there are multiple rows at the start or end
time, the print out may include more data
than was actually selected.

Chart/Message table

Chart or message table showing data
specified by Batch, From or Duration
entries.

Batch/From

Spreadsheet

Current View

Selected Range

Batch or From

Column widths
The spreadsheet is printed using the same font as the message table.
The width of the timestamp column is defined such that a full date/time string fits within it. The widths of the
other columns are then calculated in such a way as to keep the relative widths the same as they are in the
spreadsheet.
If the font and margin settings result in the timestamp column taking more than half the available width, the print
is aborted, with an error message.
If the available width is insufficient for all required columns to fit onto one page, remaining items are printed on
further pages. The first column of each page is the timestamp, and the final column on each page is expanded to
occupy any remaining width.
If a message is too wide for its column width, the message is ‘folded’. Process values are never ‘folded’.
Page Setup
Click on this button to call the Page Setup dialogue box.
Layout
Clicking on this key calls the Layout dialogue box. This allows headers and footers to be setup for the printout,
and also allows the time per page to be defined. See ‘Page Layout ’, below.
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2.11.1 PRINT SETUP (Cont.)
Preview
Clicking on this button calls a print preview to the display. this preview shows what the printout will look like. If
required, printing can be initiated from this page. For more details, see Print Preview, below.
Print
Clicking on this key calls the standard Windows print dialogue, allowing a printer, number of copies, print range
etc. to be selected.
Close
When operated, this button closes the dialogue box, saving any changes that have been made.
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2.11.2 Page Layout
Header/Footer

Note: Header and footer font is selected in the Options Menu.
HEADER
Caption

Click on this tickbox to enable caption printing. If enabled, the caption text appears near the
top left corner of each page.

Caption Text

This box is used to enter the text to be used as the caption. This text entry box is not
available unless the Caption tickbox had been enabled.

Batch Name

If this tickbox is enabled, the batch name is printed near the top right corner of each page. If
a batch phase has been selected, the header contains the batch name, followed by the phase
name, separated by a colon (:). For example ‘00000112:Heat’, where ‘00000112’ is the batch
name and ‘Heat’ is the Phase name.

FOOTER
Date/Time of Print Checking this box causes the date and time of printing to appear near the bottom left corner
of each page.
Page x of y

If selected, this causes the page number to be printed near the bottom right corner of each
page. It appears in the ‘page x of y’ format, where ‘x’ is the current page number and ‘y’ is the
total number of pages.

Chart Name

Checking this box causes the chart filename (with extension .cgp) to be printed near the
bottom centre of each page.
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2.11.2 PAGE LAYOUT (Cont.)
Time axis

Fit to

If ‘Fit to’ is enabled, the printout adjusts its time-axis scale to fill the specified number of
pages exactly. This selection is mutually exclusive with ‘Use fixed scaling’, below.

Use Fixed scaling

Checking this box means that the time-axis of the printout is set to a constant value, and the
print occupies as many pages as is necessary. The user selects the units from picklists.

Print Scales

This allows the user to suppress scale printing. Useful when printing a chart with a large
number of channels, as otherwise there is little room left for the chart.

2.11.3 Print Preview
Print Preview gives a view of the page, according to the layout specifications, header/footer information etc.
entered in the Print Setup dialogue box, described earlier. The tool bar at the top of the page has the following
buttons:
Print

Pops-up the print dialogue box to allow the print to be initiated.

Next Page

Calls the next page for preview. The button is ‘greyed’ if there are no further pages.

Prev Page

Calls the previous page for preview. The button is ‘greyed’ if there is no previous page.

Two (One) Page

Toggles between displaying one page at a time and displaying two pages at a time, for
preview.

Zoom in

Increases the magnification of the preview, but displays less of the page.

Zoom out

Decreases the magnification of the preview, but shows more of the page.
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2.11.4 Page Setup

This page allows the required paper size and source tray to be selected, and allows margins to be set. The
orientation (portrait or landscape) of the paper is shown, but can be changed only in the Print Setup page
described above.
Paper
Size

Allows the required paper size to be selected for use by the printer.

Source

Allows the paper tray/type of paper to be selected from a picklist.

Margins
Allows Left, Right, Top and Bottom margins to be entered.
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2.11.4 PAGE SEUP (Cont.)
Printer…
Clicking on this button, causes a further dialogue box to appear, allowing the user to select the required printer.

PRINTER
Name

Displays the name of the default printer, and, if required, allows an alternative printer to be
selected using a picklist. Details of the selected printer appear beneath the selection box.

Properties

Displays the usual printer properties page, allowing paper size, orientation, binding edge (if
any) etc. to be entered.
Note:
Paper size and orientation must match those selected in ‘Page Setup ’, above.

NETWORK
For networked systems, this allows network printers to be selected.

2.12 Delete
The file menu ‘Delete’ item appears only in Instrument File Services view.
The Delete key is used to delete selected files from the instrument’s disk. This operation is possible only in
certain folders on the instrument – for example, packed data files cannot be deleted from the
internal files of some instruments.
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2.13 Copy To...
The file menu ‘Copy To...’ item appears only in Instrument File Services view.
It may be necessary for the user to log on before the command can be activated.
This function is used to copy selected files to a selected file on the desktop.
If a single file is selected for copying, the file can be copied to a different name.
If multiple files are selected, they are copied to their existing filenames, and any user entry in the filename box of
the Copy Destination dialogue box are ignored.
If the copy is aborted at any time, all the copy is lost.
Note:
See ‘Selecting Files ’ for multiple file selection techniques

2.14 Copy From...
The File menu ‘Copy From...’ item appears only in Instrument File Services view. It may be necessary to log on
before the command can be activated.
This function is used to copy files from a folder on the desktop to the instrument disk. If the file is already
present on the disk, the copy will fail.
If the copy is aborted at any time, all the copy is lost.
Notes:
1.

See ‘Selecting Files ’ for multiple file selection techniques.

2.

The copy from operation is not valid for certain folders on some instrument types.

2.15 Save...
The File Menu ‘Save...’ item appears only in Instrument File Services view. It may be necessary for the user to log
on before the command can be activated.
The command is used to save the selected instrument’s configuration to a file on the instrument’s disk. Once the
program has instructed the instrument to save its configuration, it waits indefinitely for the operation to
complete. The ‘Abort’ button allows the wait to be cancelled, and another instrument to be accessed if required.
Note: Not all instrument types support this operation.
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2.16 Load...
The file menu ‘Load...’ item appears only in Instrument File Services view.
It may be necessary for the user to log on before the command can be activated.
This command is used to load a selected configuration file into the instrument, from the instrument’s disk. Once
the program has instructed the instrument to load its configuration, it waits indefinitely for the operation to
complete. The ‘Abort’ button allows the wait to be cancelled, and another instrument to be accessed if required.
Note: Not all instrument types support this operation.

2.17 Properties
The file menu ‘Properties’ item appears only in Instrument File Services view.
This command is used to display information relating to one or more selected items.
If the mouse cursor is in the instrument (left-hand) pane, then the Properties command displays information
relating to the highlighted instrument.
If the cursor is in the file directory (right-hand) pane, then the Properties function produces information related
to the selected file(s).
Note: See ‘Selecting Files ’ for multiple file selection techniques.

2.18 Selecting files
A single file is selected by clicking on the file name.
Consecutive files can be selected by holding the shift key down, then clicking on the first and last names required.
To select non-consecutive files, the Ctrl key is held down whilst the required names are clicked on individually.

2.19 Exit
The file menu ‘Exit’ command ends the Review session. Review prompts the user to save any changed documents
which are not in a saved state.
Shortcuts:
1.

icon.

2. Alt + F4
3. Double click on the Application Control menu, then click close.
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3

Edit Menu

3.1

Instrument File Services View

In Instrument File Services view, this menu contains two items:

3.1.1 Select All
Used to select all the files in the directory (right-hand) pane.

3.1.2 Invert Selection
Used to deselect all selected files and to select all non-selected files in the directory (right-hand pane)

3.2

Standard View

When not in Instrument File Services view, the edit menu also contains two items:

3.2.1 Copy
If a chart is currently displayed, the edit menu ‘Copy’ item can be used to copy the displayed chart to the
clipboard from which it can be pasted into a word processing or graphics package as required.
If a spreadsheet is on display, the ‘Copy’ item copies all selected rows to the clipboard from which they can be
pasted into a spreadsheet package if so desired.
Note: Spreadsheet view is available only to ‘Full ’ version users.
Shortcut: <Ctrl> + <C>

3.2.2 Select All
Used to select all the files in the directory (right-hand) pane. ‘Select All’ can also be used to select all items in a
spreadsheet. (Spreadsheet view is available only to ‘Full ’ version users.)
Shortcut: Ctrl + A
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4

View Menu

4.1

Menu items

The View menu offers the following commands
Toolbar

Shows or hides the toolbar

Status Bar

Shows or hides the Status bar.

Log Window

Displays a window showing comms transactions.

If the Instrument Interface feature is enabled, the following items also appear in the View menu:
List

Displays the names (only) of the files in the directory, in alphabetical order

Details

Displays all details of the files in the directory, initially in order of date and time last
modified, most recent first.

Arrange Icons

Allows the user to select name, type, size or date as the directory pane sort order.

Refresh

Allows the operator to update the displayed information for the instrument selected in the
left-hand pane.
Short cuts:
1.
F5 function key
2.
Double-click on the required instrument name in the left-hand pane.

View menu open shortcut: Alt + V

HA027962NLG
Issue 15 Dec 16

Page 53

REVIEW HELP MANUAL (VERSION 4.7.0)

4.2

Toolbar

This view menu command toggles the toolbar on and off. The toolbar, depicted below, contains a number of
shortcuts to common commands
Toolbar Shortcut:
1. Alt + V, then T, toggles the Toolbar on and off.

New Chart

Allows the user to create a new chart. See
‘New Chart ’ in the file menu

Open Chart

Allows the user to open an existing chart. see
‘Open chart ’ in the file menu

Save Chart

Allows the user to save the chart. See ‘Save
Chart ’ in the file menu

Cut/Copy/Paste

Not applicable to this software version

Go To

Allows the user to move to a specific part of
the chart, defined either by time and date, or
by Batch. see ‘Go To... ’ in chart menu.

Print

Allows the user to print the current chart or
spreadsheet*. See ‘Print ’ in file menu.

Help

Allows access to the Review Help pages. Also
accessible via the Help menu.

Toggle View
mode

For ‘Full’ version users only. This allows the
user to toggle between chart and spreadsheet
views. See ‘Chart Setup Dialogue Box ’ in file
menu

Time-per pixel

For charts, this allows the user to select the
amount of trace history which is to occupy the
chart width. For spreadsheets*, this window
allows the user to select a fixed sample interval
(unless ‘Raw Data’ is selected, when the sample
interval is that of the archiving instrument).
See ‘The Spreadsheet ’ in ‘Introduction’

* Spreadsheet view available only to ‘Full ’ version users.

Page 54

HA027962NLG
Issue 15 Dec 16

REVIEW HELP MANUAL (VERSION 4.7.0)

4.3

Status Bar

This view menu command toggles the status bar at the bottom of the review window on and off.

The left hand end of the Status bar can contain the following items:
1. A description of the user’s current action. In the top left part of the figure above, the user has selected
‘New Chart’ from the file menu. The status bar, in this case, carries the message ‘Create a new chart’.
OR
2. A description of the function of a tool-bar icon if the cursor hovers over it. In the top right part of the figure
above, the mouse cursor is hovering over the ‘New Chart’ icon. The Help system shows ‘New Chart’ at the
cursor, and the Status bar carries the message ‘Create a new chart’.
Note:
For the sake of compactness, the figure above is a composite of both situations. The two are, of course,
mutually exclusive, as the mouse cannot be opening the file menu and hovering over the tool bar at the
same time.
The right hand end of the Status Bar, the three boxes contain CAP, NUM or SCRL if Caps Lock, Num Lock or
Scroll Lock, respectively, are active at the PC keyboard.
If ‘Security Enable’ is checked in the Security\Setup menu, the window to the left of the CAP, NUM, SCRL boxes
contains details of the current login. The window contains either the text ‘No User is logged in’ or the Full User
Name of the currently logged-in user (as set up in Security Manager).
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4.4

Log Window

This View menu item causes the above Comms Log display to appear. This gives the history of communications
between the host and the target instrument.
The selection buttons at the bottom of the display allow the user to choose whether this window appears
automatically after each communications transaction, or whether it is displayed only when the user requests it,
via the view menu.

4.5

List

This view menu command, available only in Instrument File Services view, causes a list of filenames to appear, in
alphabetical order. Size, date etc. are not shown.
Mutually exclusive with 'Details'.

4.6

Details

This view menu command, available only in Instrument File Services view, causes file details including size, date
etc. to be shown. Mutually exclusive with 'List'.
Although initially displayed in date/time order (most recent first), the files can instead be sorted by name, size
or type, by clicking once on the column heading. A second click on the heading inverts the order.
The ordering of files can also be modified using the view menu 'Arrange icons' item.

4.7

Arrange Icons

This view menu command, available only in Instrument File Services view, allows the user to sort the files in the
directory (right-hand) pane in any one of the following ways:
By Name

Shows files in file-name alphabetical order

By Type

Shows files in file-type alphabetical order

By Size

Shows files in file-length order

By Date

Shows files in order of date and time last modified.
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5

Instrument menu

5.1

Menu items

The instrument menu commands are:
File Services

Provides password-controlled access to instruments, with disk maintenance and file transfer
facilities

Log off

Terminates a session on some or all instruments

Log off This

Terminates a session in the currently selected instrument.

Auto Backup + Transfer
Presets the unmanned periodic Backup and Transfer of instrument files.
Setup

Allows TCP/IP instrument settings to be made.

Shortcuts:
File services:

Ctrl + i

Logoff:

Ctrl + L
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5.2

File Services

This window provides an on-line one-to-one interface with instruments defined in ‘Instrument setup ’, described
below. The file services window is accessed either from the instrument menu or by the shortcut Ctrl + i.
All access to instruments is password controlled. For most models a number of access levels apply, and access to
the various instrument operations is governed by the Access Permissions configured in the instrument.
When an instrument is first configured in a window, Review asks for a password. If the entered password does
not match the relevant password defined in the instrument, it will be rejected. Once a password is accepted, the
user is ‘logged on’ to the instrument and can activate further commands at the same access level.
If an attempt is made to run a command requiring a higher level of access, the user will be prompted for the
appropriate password.
When no further access is required, the user should Log off from the instrument (i.e. terminate the session). On a
MODEM connection, this automatically ‘hangs up’ the line.
On selection of another instrument, the program will attempt to use the password last entered for any
instrument. This saves the user from having to enter the password at every session.
The user should log off all instruments if the PC is to be left unattended. This removes the memory of the lastentered password, thus preventing unauthorized access.
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5.2 FILE SERVICES (Cont.)
Communications are initiated as soon as the instrument identifier in the left pane is clicked-on. At first access
each session, a user name and password are required, When a successful link is established, all information
regarding the selected instruments disk appears as a list of files in the directory (right hand) pane.
An instrument or file is ‘selected’ when it is highlighted in a solid colour.
Once one or more items are selected, access to commands applicable to those items is via the menu bar or
shortcut menus.
To select multiple contiguous items, hold down the shift key, and click on the first and last items required (or
click/drag (using the left hand mouse key) over the required group of filenames).
To select multiple individual items in a window, hold down the ctrl key and then click each item to be selected.
To select all the files in an instrument directory, either:
1.

Click on Select All in the edit menu

2.

Click the mouse right hand button, then click ‘Select All) in the pop-up menu.

To invert a selection, click on ‘Invert Selection’ in the Edit menu

5.2.1 Instrument Name
The instrument name (in the example above, Instrument TCPIP 1) appears in a box above the left corner of the
directory pane.

5.2.2 Last Refresh
The time and date at which the directory pane was last updated (11/06/03 12:18:35 in the above example)
appears in a box above the right-hand corner of the directory pane.

5.2.3 File Type
The user may select ‘Archive Files’, ‘Non-archive files’ or ‘All files (*.*)’ from a picklist below the directory pane.

5.2.4 Archiving On during Copy
This selection is available for only some recorder models.
For those models to which it applies, this box, if ‘checked’ allows archiving to continue during file copying
between the instrument and the PC. If the box is not checked, archiving is suspended during file transfer, thus
leading to a reduction in communication time.
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5.2.5 Comms Logging to instrument disk
This selection is available for only some recorder models.
For those models to which it applies, this box, if checked, causes the instrument to log all communications
transactions to a file on the instrument disk. If not checked, no such record is made.

5.3

Log off

The logoff window can be called either from the instrument menu, or by using the shortcut: Ctrl + L
The logoff window lists all currently defined instruments. The user can select on or more instruments and then
click on OK to initiate the log off (i.e. to terminate the online interface). With MODEM connections, Log Off
automatically ‘hangs up’ the line.

5.3.1 Select All
This selects all instruments. Before leaving the PC unattended, it is recommended that ‘Select All’ be used to
log out of all instruments, so that any subsequent user must provide a valid password before being able to access instrument
files.

5.3.2 Invert All
This selection simultaneously de-selects all selected instruments, and selects all non-selected instruments.
See ‘Selecting Files ’ for details of how to select multiple files.

5.4

Log Off This

This instrument menu command is accessible only in Instrument File Services view, and is used to log off from
the currently selected instrument (i.e. the online interface is terminated). With MODEM connections, 'Log Off
This' automatically 'hangs up' the line to the selected instrument.
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5.5

Autobackup and Transfer

Notes:
1.

It is recommended that this section be read through in its entirety before any attempt is made to use the
feature.

2.

If the Auto Backup + transfer facilities are left enabled when review is closed down, then files will start
being copied and / or transferred automatically (i.e. without operator intervention) when Review is next
started.

This instrument menu command, allows the automatic, periodic copy of selected files from the instrument to the
desktop, followed by the transfer of some or all of the received files to the Review database.
It is strongly recommended that:
1. Wherever possible the source instrument is configured with a meaningful name, and that this name be used as
the Instrument Identifier in the Instrument setup dialogue box.
2. The first time Auto backup + transfer is used, ‘Transfer to Database’ is deselected in the dialogue box. This
means that when the ‘Transfer Now’ button is clicked, data is backed-up from the instrument, but not
transferred to the database. These files contain old data files from the instrument which may be invalid
because they were produced before the instrument configuration was complete, and which therefore contain
incorrect tags/descriptors/instrument names etc. If the files are required, they can be transferred to the
database manually, from the Instrument File Services page.
The next time Auto-backup + Transfer is used, only current data files will be backed-up (and transferred to the
data base if ‘Transfer to Database’ is enabled).
When backup falls due, Review carries out the following procedure:
1. Review logs on to the selected instrument, using the password entered in the dialogue box.
2. For relevant instrument models, if ‘Archiving On during backup’ is not selected, Review tells the instrument to
suspend archiving.
3. All files of the type specified in the dialogue box ‘Files to Back-up’ window are copied from the instrument to
the desktop folder specified in ‘Destination’. If ‘Delete files from instrument after backup’ is set, each file is
deleted from the instrument disk after a successful copy. Note that for some instrument models, only new or
updated files are backed-up.
4. Review then re-enables archiving, if previously disabled, and logs off from the instrument.
5. If ‘Transfer to Database’ is enabled, Review then transfers all those received, Packed, Archive files whose
names match the ‘Backup files to transfer’ setting into the database. All batches are placed in a database area
named ‘Tag’. If ‘Export to CSV file’ is also enabled (only if ‘Running as a Service ’ is enabled), the files are
converted to comma-separated variable format, and saved to the specified path name. CSV format is defined
in ‘Settings ’ in the Options menu.
All transactions and errors are logged to the Comms ‘Log window’ as described in ‘View Menu ‘, and also to the
file comm.log in the same folder in the database. The Log window can be configured to open automatically after
each transaction, or to be available only through the View Menu. See also TCP/IP in Instrument setup.
Redundant instruments
For Redundant pairs of instruments (i.e. a synchronized primary and a secondary pair running in parallel), both
instruments have to be set up by specifying their IP addresses. The same back-up folder can be specified for the
two instruments, or they can be assigned to separate folders.
The configurations in both instruments have the same instrument name, so data is imported automatically as
primary and secondary for that instrument name
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5.5.1 Dialogue box

The description of this dialogue box is ordered as follows:
1. Background area items (e.g. Instrument User Name)
2. BACKUP area items
3. FILE TRANSFER area items
4. AUTOMATE area items
When OK is pressed check boxes, as shown below, appear for Windows 7. See also ‘Running Review as a Service’’,
section 0 - (the XYNTService box appears twice).
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5.5.1 AUTO BACKUP AND TRANSFER DIALOGUE BOX (Cont.)
Background Area
Run as a Service

See Running Review as a Service for details. It should be noted that ‘Run as a
Service’ can also be enabled/disabled in Scheduled Transfer. If enabled in one, it is enabled in
the other, and vice-versa. ‘Export to CSV file’ can be enabled only if ‘Run as a Service’ is
enabled.

Instrument list

Lists the instruments currently defined in Instrument Setup, described later in
this document. Where parameters are common to more than one instrument, it may be
productive to select all the relevant instruments, and then enter the remaining data only once.
Any conflicting parameters are shown blank, or with a ‘greyed’ checkmark.

Select All
Invert All

Selects all instruments in the instrument list.
Simultaneously selects all previously unselected instruments, and deselects all
previously selected instruments.

Instrument User name This is the user name or access level which is used when Review connects with the
instrument.
Instrument Password
Transfer now
OK
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This is the password used when logging-in at the instrument.

Once the setup has been completed, the operation can be checked by clicking on this
key to initiate an immediate backup and/or transfer. The ‘Next Run’ time is not affected.
Once the setup has been completed, it is saved by clicking on the ‘OK’ button.
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5.5.1 AUTO BACKUP AND TRANSFER DIALOGUE BOX (Cont.)
BACKUP area

Enabled:

Clicking this box enables automatic copying of files from the instrument to the folder entered
in the ‘Destination’ field. It is accepted, therefore, only when all other relevant parameters,
including the password, are valid. If this box is left unchecked, the settings are preserved, but
the backup does not take place.

Files to backup:

Allows the user to select, from a picklist, the type of file to copy during backup. Selectable
types are: Archive Files, Non-Archive Files and All Files (*.*). If ‘Non-archive Files’ is selected,
then backup will take place, but no transfer to the database will occur.

Destination:

This defines the folder to be used for the backup. The entry must be a full path name in the
format shown in the figure above. (In this case, the relevant hard disk drive is drive ‘d’.) It is
recommended that a separate folder be used for each instrument, and that each folder’s
name is the same as that of the associated instrument, both as displayed in the Instrument list,
and as configured at the instrument itself.

Archiving on during backup
Applicable to only some models. If not applicable, the item is ‘greyed’ (as in the example
above). For applicable instrument types, clearing this checkbox switches off the instrument’s
archiving function for the duration of the backup. Communication speed is increased, at the
risk of losing of data samples.
Delete files from instrument after backup
Applicable to only some models. If not applicable, the item is ‘greyed’ (as in the example
above). If this box is checked, files are removed form the instrument disk once they have
been successfully copied to the desktop. This has two advantages: it creates space on the
disk, and it prevents the same data from being copied again at next backup.
Once a file has been deleted, the instrument might use a deleted filename again. Should this
occur, subsequent backups allocate a suffix (_NN) unique to each instance of the filename, to
ensure that previous data is not overwritten.
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5.5.2 FILE TRANSFER area

Backup files to transfer:
The names listed here can include only Packed Archive data files, copied in the backup.
Names must be specified without extension, and must be separated by semicolons.
Names can include DOSA filename wild characters – some typical examples are as follows:
*

Includes all Packed Archive files

LOG_02

Includes all Packed Archive files with base name LOG_02

LOG*

Includes all Packed Archive files beginning with LOG

LO0?????;LO1?????
Includes all Packed Archive files with 8-character filenames beginning with LO0 and LO1.
Furnace~*

Includes all Packed Archive files in group ‘Furnace’. (This wild card usage is not applicable with
some models.)

Instrument tag if not configured in the instrument:
The instrument tag under which the data from this instrument is to be stored. For units that
do not include an instrument tag with the data, then the entry in this dialogue box is used.
For other instruments, if the instrument tag is still the default, then the entry in this dialogue
box is used. If the instrument tag has been edited (configured), then the edited tag is used
and any entry in this dialogue box is ignored.
TRANSFER TO DATABASE
Enabled

Checking this box enables the transfer of Packed Archive data to the database, once backup
has been completed. The enable is accepted only when all other transfer parameters are
valid.

EXPORT TO CSV FILE
Enabled

Checking this box enables the conversion of data files to comma-separated-variables (.csv)
format. The enable box is available for editing only is ‘Run as a Service’ is enabled.

Destination

Allows the user to define a path name for CSV files, either by browsing, or by typing-in the
path name.
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5.5.3 AUTOMATE area

This area allows the user to set up a start time and repeat interval for the Auto-Backup + Transfer function. A
checkbox also allows the user to carry out a backup/transfer function whenever a new filename is detected.
Next run:

This allows the user to specify an initial day number and time for the first backup to take
place. This value is automatically updated after each backup, according to the setting in the
‘Repeat every’ window below. For the settings in the example above, the Auto Back-up +
Transfer function would run every day at 1 a.m., starting on the 15th of the month.

Repeat every:

This allows the user to select a repeat period for Auto Back-up + Transfer, starting from the
specified time and day number entered in the ‘Next Run’ window, above. The period is
selected from a picklist of 5, 15 or 30 mins; 1, 2, 8 or 12 hours; every day; every week; every
month, or, if ‘0’ is selected, Autobackup + Transfer is inhibited. See ‘Note’, below

Also run immediately new file detected
Clicking on this box causes Review software to check the instrument, every minute, for new
files. If a new file is detected (see ‘Note’ below), a backup/transfer operation is carried out
immediately, no matter what the automatic repeat rate setting.
This feature can be particularly useful in combination with the Automatic Print feature. For
example, if the instrument is configured to ‘Name files by Batch’, then, when a batch finishes,
the current file is closed and a new one opened. This initiates a Backup/Transfer operation,
and activates automatic printing.
Note: If ‘0’ is selected in ‘Repeat every:’, and ‘Also run immediately new file detected’ is enabled, then a
transfer occurs only when a file is closed and a new one opened, and only the closed file(s) are
transferred. This means that each file will be transferred (and CSV files generated) only once. If a
‘Repeat every:’ value other than ‘0’ is selected and ‘Also run immediately…’ is enabled, then the scheduled
transfer causes all files (including open ones) to be transferred, but intermediate transfers, triggered by
new file detection, transfer only closed files.
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5.6

Setup

This instrument menu item is used to identify instruments.

This dialogue box is entered from the Setup command in the instrument menu.

5.6.1 Instrument pane
The instrument pane, in the left-hand side of the window, shows all the instruments that have so far been
defined. The ‘Add Instrument’ and ‘Remove Instrument’ keys allow new instruments to be added to, and existing
instruments to be removed from the list at will. Records are not updated until ‘OK’ is clicked.
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5.6.2 Other items
TCP/IP Address or Host Name
This field contains the TCP/IP address of the instrument, or the name by which it is known on
the network.
Identifier

The name by which the instrument is known within the software. It is strongly recommended
that each instrument be configured (at the instrument) with a meaningful name, and that this
name be used as the identifier both here, and anywhere else where an identifier is used.

Connect timeout

The number of seconds to wait whilst attempting to establish connection with an instrument.
If the instrument and the PC are both on a local network, then a setting of one second should
be adequate. If communication is via a dial-up connection, then it may be necessary to set
the timeout to a much greater value in order to allow time for the dial-up to complete. Valid
entries are 1 second to 600 seconds (10 minutes), inclusive.

Transaction Logging to
If this box is ticked, all communications activity is logged to the file ‘Comm.log’ in the same
folder as the database. Errors are always logged whether encountered in File Services, or Auto
Backup +, Transfer processes.
Use proxy for FTP If this box is checked, the proxy server specified in the Internet properties dialogue in the PC
control panels area is used.
Use Passive FTP

If checked, the passive FTP protocol is used for file transfers.

Add Instrument

Adds a default instrument to the end of the list.

Remove instrument
Removes the highlighted instrument from the list of instruments.
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5.7

Running Review as a Service

Note: When running Review as a Service on a multi-user pc, it is not recommended that the ‘Switch User’
capability be used to switch away from the user who has been configured to run the service. Log Off/Log
On must be used instead.
This feature is available only to users of the Full version of Review.
Running Review as a Service is initiated by checkbox selection in ‘Auto Backup and Transfer ’ (Instrument menu)
and/or ‘Scheduled Transfer ’ (file menu) setup pages.
To run Review as a service the user must first set up the PC which is to run the service. See ‘PC Setup’, section
5.8, for details.
When the user selects ‘Run Auto Backup + Transfer as a Service’ or ‘Run Scheduled Transfer as a Service’, the PC
user name and password are requested for the account to be used to run the service. The dialogue box includes
instructions relating to the entry of user name with PC name or Domain name.
The specified user name must have ‘Log On As a Service’ right. This is generally set up by Review, but should it
fail, see ‘PC setup’, section 5.8, for details.
The user must have access rights on the PC to allow the installation of services.
Any errors encountered during this process are logged to a file rather than being displayed to the user.
These check boxes appear when Review
is run in Windows 7.
The check box for Program name
XYNTService is shown twice.

When running as a service, closing
Review closes the foreground
operation, but leaves the service
running to continue with the Auto
Backup + Transfer operations. Double
clicking on the Review icon in the
‘System Tray’ at the bottom right-hand
corner of the screen, re-opens Review.

Notes
1.

When Review is running as a service, it performs back-up and transfer tasks even if no one is logged into
the PC

2.

When Review is running as a service, any auto archive activity takes place without prompting the user, even
if ‘Prompt user before performing Archive/Delete’ is enabled in the `Setup Database Auto Archive ’ page.
Compacting the data in the database will also take place without operator intervention.
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5.8

PC Setup

When Review is run as a service it is necessary to provide the username and password of the user under which the
service is to run. This user must have "logon as a service" access in Windows. This is set up as follows:

5.8.1 Windows 7:
Select: Control Panel, Administrative Tools*, Local Security Policy, Local Policies, User Rights Assignment.
Double click "Log on as a service" .
Click Add.
Enter the User, Group or Everyone as appropriate.
Click Add to Add them.
OK each dialog.
* it may be necessary to select View By ‘icons’ or search for ‘Administrative Tools’

5.8.2 Windows XP
Depending on set up, either select: Control Panel, Administrative Tools, Local Security Policy, User Rights Assigned
or select: Control Panel, Performance and Maintenance, Administrative Tools, Local Security Policy, Local Policies,
User Rights Assignment.
Double click "Log on as a service".
Click Add User or Group and enter the user name required.
Click Check Names to verify a valid name has been entered.
OK the dialogs.
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6

Chart menu

6.1

Chart Menu items

The Chart menu (active only when a chart is open) offers the following commands:
Setup

Sets up chart options and specifies which points to display. This topic is fully described under
file menu ‘New Chart ’ earlier in this document.

Go To...

Allows a section of chart, or a specified batch to be selected for view.

Annotate

Allows the user to add a message to chart and archived data.

Refresh

Allows the user to redraw the chart with the latest data.
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6.2

Go To...

This command, accessed from the chart menu, or via the GoTo toolbar button (
specific area of the chart, or spreadsheet (‘Full’ version users only).

), is used to jump to a

Relative Date and Time
This allows the user to move the current chart a specified number of time units backwards or
forwards through the data, from the current point.
Specific Date and Time
This allows the user to move to a specific date and time in the data.
Batch
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Allows the user to move to the start of a specified batch of data. For those instruments which
support Batch Phases, this allows the user to navigate to the start of a specified phase of the
batch.
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6.3

Relative Date and Time

This description is written for chart displays. For ‘Full’ version users, the function also applies to spreadsheet
views.
This GoTo... button is clicked to select Relative Date and Time, and is used to move the start of the chart view
(left edge) forwards or backwards by a specific number of days, hours or minutes. The button is mutually
exclusive with the ‘Specific date and time ’ button.

The required days, hours and minutes are entered using the three time boxes, then ‘forward’ or ‘back’ selected
from the ‘Move’ box. Subsequent clocking of the ‘OK’ key causes the chart to jump to the selected location.
If the selected location lies outside the range of data held on the database for this chart, the chart still appears,
but is blank, with faceplates reading ‘No Data’.

6.3.1 Duration boxes
If a specific time span is required, then the ‘Duration’ boxes can be edited to override the current ‘magnification’
setting.
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6.4

Specific Date and Time

This description is written for chart displays. For ‘Full’ version users, the function also applies to spreadsheet
views.
This GoTo button is clicked to select Specific Date and Time. This feature is used to move the start of the chart
view (left hand edge) to a specific date and time. The button is mutually exclusive with the ‘Relative date and
time ’ button.

The required time is entered by clicking on the required hours, minutes or seconds, then either entering a value
from the keyboard, or using the up/down arrows.
The required date is entered either
a. By clicking on the individual date figures and editing them from the keyboard.
b. By clicking on the down arrow symbol to the right of the date. This causes a calendar page to appear. Month
is selected using the right/left arrows at the top, and the day number selected by clicking.

Subsequent clicking of the OK key causes the chart to jump to the selected location.
If the selected location lies outside the range of data held in the database for this chart, the chart still appears,
but is blank, with faceplates reading ‘No Data’.

6.4.1 Duration boxes
If a specific time span is required, the ‘Duration’ boxes can be edited to override the current ‘magnification’
setting.

Page 74

HA027962NLG
Issue 15 Dec 16

REVIEW HELP MANUAL (VERSION 4.7.0)

6.5

Batch

This description is written for chart displays. For ‘Full’ version users, the function also applies to spreadsheet
views.
This area of the GoTo dialogue box is used to move the chart view to the beginning of a specified batch. The
batch name can be typed-in, selected from the pull-down picklist, or the batch name can be searched for using
the batch selector dialogue, described below.

6.5.1 ‘Active after’/’Active before’ filters
The ‘active after’ and ‘active before’ filters allow the user to define a specific time range within which the required
batch is to be found. This filter acts on both the ‘Find batch’ browser and the Batch name drop-down list.

6.5.2 Find Batch
Clicking on ‘Find Batch’ causes the ‘Batch Selector’ page to appear.

The figure above shows the minimum data that can appear for any batch in the database. This consists of the file
name, Start time and End time. In addition to these columns, the dialogue box may contain other columns for
Product Code, Started By, Stopped by etc.
(Continued)
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6.5.2 FIND BATCH (Cont.)
Individual column widths can be adjusted by click/dragging the column separators in the header bar.
Clicking on a column’s header, causes the batches to be sorted according to the data in that column, in
alphanumeric order. A second click reverses the sort order.
A Batch is selected for the GoTo function, by clicking it once, then clicking OK, or by double clicking anywhere in
the relevant row.
The list contains only those files which lie within any ‘active after’ and ‘active before’ time and date range
selections made as described above.
Search
In order to locate a batch, any one or more of the characters included in the batch name are typed into the
Search box, and the ‘Find First’ button clicked. If any batch names containing the entered characters are located,
then the first of these appears highlighted in the table. ‘OK’ selects this batch and closes the dialogue box.
Alternatively, ‘Find Next’ searches for and displays the next batch name containing the entered string.
Notes
1.

Search characters are not case sensitive

2.

Start time and end time are not included in the search.

6.5.3 Batch Name
A batch can be selected from the picklist.

6.5.4 Phase
This selection window is ‘greyed’ for instruments which do not support batch phase.
For instruments which do support batch phase, the pull-down menu gives a list of phases associated with the
batch. Clicking on a specific phase, then on ‘OK’, causes the chart to jump to the start of the selected phase.

6.5.5 Merge batches with matching descriptors
If this radio button is active, then all batches with the same name are merged and the start and end times are
determined from the earliest and latest batch records in the database.
If the button is not selected, then the batch start date is appended to the batch name(s) in the drop-down list.

6.5.6 Show entire batch/phase
This box is checked if the chart or spreadsheet window is to show the entire batch or phase from start to finish,
including any text messages at the end of the batch.
If the entire batch is not needed, the duration buttons can be used to set a specific time period. In such a case,
the chart view starts with the start of the batch, and spans the specified duration.

6.5.7 Hide data from other batches/phases
A chart can contain traces and messages from more than one batch, and may contain traces that are not
associated with a batch at all. In such cases, it is sometimes clearer if only those traces associated with the
required batch, or phase are displayed. To achieve this, ‘Hide data from other batches/phases’ should be
selected. This selection also removes any pre-batch/phase and post-batch/phase data.

6.5.8 Save Batch Name with Chart
If this item is selected, Batch settings are saved with the chart. This means that when the chart is re-opened, the
batch settings continue to apply.
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6.6

Annotate

This dialogue box, accessed from the chart menu, allows the user to enter text messages to the archived data.
The message is displayed on the chart like a normal text message.
If Security is enabled, then annotation may have to be signed for (User name and password) according to the
Security Manager configuration for the logged-in user.
The annotation is stored in the database, and therefore appears on any chart that includes points from the group
to which the annotation message is ‘attached’.

A confirmation of the message is requested before the message is added to the chart:

Once the annotation has been entered, it cannot be edited or deleted.
Instrument

An instrument is selected from the pull-down pick list.

Log Group

A log group can be selected from the pull-down pick list
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6.6 ANNOTATE (Cont.)
Annotation Timestamp
The displayed default time and date for the entry of the message, are those of the cursor.
The Annotation timestamp fields allow the user to select another time and date for the
message to appear on the chart. Both the chart date and time and the date and time at which
the annotation is created are included in the message.
In the example:
03/03/04 12:51:29 Approved, Signed ADMIN 16/03/04 14:58:15 Batch Approved
the first timestamp (03/03/04 15:51:29) is the date and time at which the message is located in
the chart. The second timestamp (16/03/04 14:58:15) defines when the annotation was added
to the chart.
The required time is entered by clicking on the required hours, minutes or seconds, then
either entering a value from the keyboard, or using the up/down arrows.
The required date is entered either
a. By clicking on the individual date figures and editing them from the keyboard.
b. By clicking on the down arrow symbol to the right of the date. This causes a calendar page
to appear. The required month is selected using the right/left arrows at the top, and the
day number selected by clicking.

User

This read only field shows the User Name currently logged in at the PC. The user name is
included in the count for the maximum number of characters (255) that can be entered as the
annotation message.

Annotation

An annotation message of up to 255 characters (including the User name) can be typed into
this window. Further characters are ignored, with an audible warning being given.

6.6.1 Reason
This allows one of ‘Note’, Reviewed, Approved or Released to be selected for annotation type. Each of these
headings may have a different access permission set in security management, allowing only authorized personnel
to annotate the chart.
Security Notes must have a text string typed-in. ‘Reviewed’, ‘Approved’ and ‘Released’ can have text appended
(‘Batch Approved’ in the above example) or not, as required.
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6.6.2 Sign
If security is enabled, then an appropriate User name and password must be entered before any chart annotation
can take place.

6.7

Refresh

This Refresh command is accessed either from the Chart menu or via the shortcut function key F5.
The command causes the chart to be redrawn using the latest database values.
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7

Security Menu

7.1

Introduction

This menu bar item’s functions are available only in the Full version of Review software and then, only if Security
Manager is installed. If either of these criteria is not met, the menu functions are ‘greyed’, and thus are not
selectable.
Note:
Before enabling security in Review, a ‘Security item’ of type ‘Review S/W’ must be added, as described in
the Security Manager help pages. Otherwise the ‘Enable Security request will fail, with an error message.

Clicking on ‘Security’, calls the Security menu:

This contains the following items:
Login...
Logout
Setup...
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7.2

Login

This item is selectable only if Setup... has already been carried out. Clicking on ‘Login...’ causes the Login dialogue
box to appear:

The default User name is ADMIN; the default password (case sensitive) is ADMIN , but either or both of these may
have been changed in Security Manager.
This login box also appears whilst enabling Security
Note:
When a user is logged in the associated ‘Full user name’ is displayed in the status bar at the bottom of the
display window.

7.3

Logout

This menu item is available only if an operator is already logged in. Logout is immediate with no confirmation
request.
Note:
When a user logs out the Full user name window, displayed in the status bar at the bottom of the display
becomes empty (if ‘Enable Security’ is disabled) or contains the text "No user is logged in" (if ‘Enable
Security’ is enabled).
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7.4

Security Setup...

Setup... appears if ‘Enable Security’ has not yet been enabled or if a user is logged in who has ‘Administration’
permission to the Review software instance configured in Security Manager.

The ‘Security Database_File_menu Path must be the same as entered for this copy of Review, in Security Manager.
When ‘Enable Security’ is enabled, and ‘OK’ operated then, if the pathname is correct, the user is asked to login:

OK calls the login box as described in ‘Login ’.

If the login path is incorrect, an error message is displayed, and request to Enable Security is ignored.
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7.5

Enable Security effects

With Security enabled, the Security Manager software can allow/deny the Review user access to most Review
functions. The items which can be enabled/disabled by the Security Manager software are arranged as a number
of checkboxes, as follows:
Transfer files:

The transfer of data into the database by manual means. Auto backup + transfer continues
even if transfer files is disabled.

Chart setup:

The making of new charts, the editing of charts and the saving / saving as.. of charts. Includes
changes made by point properties.

Chart Open/close: The opening and closing of charts. If disabled, only the chart(s) on the screen when Review
was last used will be visible, or only the chart opened via a command line argument
Modify chart view: Includes Zoom, Chart GoTo and scroll; chart/spreadsheet toggle; View settings in Print setup.
Does not include settings in Page setup or Layout.
Save Chart:

Always enabled if ‘Chart setup’ enabled.
Save a new view of a file modified by one of the actions permitted under ‘Modify chart view’.
If ‘Save Chart’ is disabled, but the user has changed the chart view, the new view cannot be
saved before closing.
Note: ‘Save As...’ is included as part of the ‘Chart setup’ permission (above) .

Administration:

Includes Automatic print setup, Maintain Database_File_menu, Auto Backup + transfer setup,
Instrument setup, Security setup and all Options menu items.

File Services:

Instrument \File services menus

Chart Annotate

Allows the user to add notes to the chart.

Chart Review

Allows 'Chart Reviewed’ annotation messages to be sent to the chart (if Chart Annotate is
enabled)

Chart Approve

Allows ‘Chart Approved’ annotation messages to be sent to the chart (if Chart Annotate is
enabled)

Chart Release

Allows ‘Chart Released’ annotation messages to be sent to the chart (if Chart Annotate is
enabled)

Print:

The printing of charts and spreadsheets.
In order to modify Print Range in the print setup dialogue box, Modify Chart View (above)
must be enabled.
To modify other setup data, Print Setup (below) must be enabled.

Print Setup

Full access to Print setup, except for Print Range, which is modified by ‘Modify Chart View’
(above).

Export data:

The Exporting of data.
To modify the export range in the export dialogue box, Modify Chart View (above) must be
enabled.
To modify other setup data, Export Setup (below) must be enabled.

Export setup:

Full access to Export functions, except Export Range, which is modified by Modify Chart View
(above).
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8

Options menu

8.1

Options menu items

This menu has the following items:
Fonts...
Master Archive Folder
Settings
Enable Review Full (demo) (Appears in ‘Lite’ version only.)
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8.2

Fonts...

This menu allows the Font face, type and style to be selected for various software features, as shown in the figure
above.
Chart font

This is the font used for the text written on the chart, and for scales drawn alongside the
chart. The text is drawn vertically. Most ‘True Type’ (TT) fonts work correctly when printed
vertically; other fonts should be selected on a trial-and-error basis.

Large font

This is the font used for the process value display within point faceplates.

Small font

This is the font used for title and range information within point faceplates.

Header/Footer font
Used for the printed headers and footers on printed charts, tables and spreadsheets.
Report font

Used for spreadsheet view print, Message table print etc.

Clicking on any of the above sub-menu items calls the Font Definition page.
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8.3

Master Archive Folder Setup

This setup window, accessed from the Options menu, allows the Master Archive folder location to be defined, for
use with the File menu Transfer From Folders or Transfer from Removable Media menu items.

If a database is being shared amongst computers, then the specification of the Master Archive Folder must be a
UNC path of the format:
\\server name\share name\path\folder name
If it is not in this format, a warning appears each time the Master Archive Folder name is configured to be
anything other than the default.
Using this format ensures that all computers copy files to the same master folder, and not to local folders in each
computer.
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8.4

Settings

This Options menu item allows default chart, spreadsheet and CSV format items to be set.

8.4.1 Default Trace Mode
This allows the trace mode to be set as described in ‘Point Properties ’ (File menu)

8.4.2 Default Chart mode
This allows Chart or spreadsheet to be selected as default viewing mode. See ‘Current Mode ’ (File menu)

8.4.3 Default Chart setup
Allows defaults to be set for message inclusion and grid divisions. See ‘Chart setup ’ (File menu).

8.4.4 Default Auto Zone settings
Auto zone defaults can be set here. See ‘Auto Zone ’ (File menu) for details.

8.4.5 Sample interval
Allows a default sample time to be entered. See ‘Chart setup ’ (File menu) for details.
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8.4.6 Show Timezone on Chart
Checking this box causes timezone information to appear, by default, on any new chart or spreadsheet. Timezone
information can be added to existing charts and associated spreadsheets using the chart setup dialogue box.
See ‘Timezone indication ’ for further details.

8.4.7 Default Spreadsheet and Export data
Allows default settings for the inclusion/exclusion of values and messages and for the use of raw data, to be
entered. See ‘Spreadsheet setup ’ (File menu) for spreadsheet details, and ‘Export ’ (File menu) for details of
exporting data.

8.4.8 Use Report Font in Spreadsheet View
This allows the user to change the default status of the tick box ‘Use Report Font in Spreadsheet View’ which
appears in the Spreadsheet Setup area of the Chart Setup dialogue box. Normally, the default setting is ‘unticked’
which means that the spreadsheet font is the system default. If this box is ticked, the font used is that selected in
‘Report Font…’ in the Options/Fonts menu.

8.4.9 Default CSV format
For some versions of software, only the file extension is editable.
This area allows the default date/time format, the separator and file extension to be defined for use when Export
to CSV is selected in ‘Scheduled Transfer ’ or ‘AutoBack-up + Transfer ’. The user can also choose whether or not
to include column headers.
Date/Time format
Text String

Causes a time/date to appear in the spreadsheet. Most spreadsheets all the time/date format
to be selected according to locale.

Spreadsheet Numeric Format
This displays the number of days since December 30th 1899. The decimal part of the value
represents the latest six hours. For example DDD---DDD.25 represents 0600 hrs; DDD--DDD.50 represents noon etc. This format is more easily interpreted than text string format by
some spreadsheets.
Separator
Selecting ‘Default Separator’ causes commas to be used to separate the variables. For locales which traditionally
use the comma for a decimal point, ‘Tab’ should be selected, to avoid confusion.
File extension
The three characters added as a suffix to file names. for CSV files, the normal extension is .csv.
Include Column Headers
If enabled, this includes column headers with the CSV files.
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8.4.9 DEFAULT CSV FORMAT (Cont.)
InSQL format
If enabled, files generated using automatic csv generation are in InSQL format. All other options in the Default
CSV section are ‘greyed out’, except for ‘File Extension’.
FILE NAMING
InSQL files have the same name as the source uhh file but with the extension (eg .csv) as specified in the Default
CSV Format section of the Options Settings dialogue. For example, assuming the extension is configured as csv,
the uhh file Group-1~20061107_8038D226000000C4.uhh would be exported as Group1~20061107_8038D226000000C4.csv.
The above strategy guarantees that file names are unique (as uhh file names are unique) so there is no danger of
csv files being overwritten before they have been actioned by other software.
Note: If uhh files are being collected on a scheduled basis then uhh files of the same name may be picked up at
successive scheduled times, each version being an extended version of the previous file. this results in the
csv file being generated a number of times with an increasing amount of data each time.
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8.5

Enable Review Full (demo)

For ‘Lite ’ version users only.
Initially, whenever Review is started, the user is asked if ‘Full’ version features are to be enabled.

If ‘Yes’ is clicked, ‘Full’ version features are enabled on a temporary basis (10 minutes). Once this period has
expired, Review reverts to ‘Lite’ operation with a warning.

If ‘No’ is clicked, Review opens in ‘Lite’ mode.
If ‘Don’t ask me this again...’ is clicked, Review will always open in ‘Lite’ version, and the user will not be given the
opportunity to select ‘Full’ features.
In such a case, the ‘Full’ features can be enabled by selecting this (Enable Review Full (demo )) Options menu
feature. Review responds with the following page.

The user must click OK, then quit Review, and restart it. Once this is done, the above ‘dialog’ box re-appears.
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9

Window menu

9.1

Window Menu items

The window menu allows the user to arrange multiple views of multiple documents in the application window.

9.2

New Window

This Window menu command opens a new window with the same contents as had the window that was active
when the 'New Window' command occurred.
This feature allows the user to view several different parts of the same chart simultaneously.
Any changes made to the chart in one window will affect all other windows containing that chart.

9.3

Cascade

This Window menu command arranges the open windows as overlapped layers. Any of the windows can be
brought to the front (i.e can be made the 'active' window) either by clicking on it, or by selecting it from the list
of open charts in the Window menu.

9.4

Tile

This Window menu command arranges the charts in a non-overlapping 'tabular' format, where all open windows
are visible simultaneously.
Note:
There is a minimum chart window width. For this reason, with some PC display resolutions, when there is
more than one column of windows, not all of the chart width is visible for windows in any but the left-most
column. The partially displayed windows must be clicked-on to bring them to the front.

9.5

Arrange Icons

This command is used to arrange the icons for minimised windows at the bottom of the main window (not the
'Start bar' icons). The command is useful if the minimised icons are no longer in the visible part of the window
for any reason, or are not arranged along the bottom of the window.
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9.6

Chart List

This Window menu function lists all the currently open charts. The currently active chart is ticked.
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10 Help menu
10.1 Menu items

This menu allows the user to open the help files associated with Review Software. Full contents and indexing facilities are included.

Help files are also accessible using the toolbar shortcut button

10.2 About Review
This Help Menu command displays the copyright and version number information for this copy of review.

11 Error messages
11.1 Error messages
11.1.1 Start time too far before existing data

If old data is transferred into a database with current data already in it, then the message above may appear.
Typically, for the message to appear, the ‘old’ data would have to be at least a year older than the earliest data
already in the database.
If the data source is an instrument in which the instrument name (descriptor) has been edited, then it is not
possible to use a new area name. In such a case, a new database should be opened, into which the data can be
transferred. See file menu\Database\New Database for details.LOGDEV upgrade

12 LOGDEV upgrade
This topic applies only to LOGDEV blocks prior to version 3.0
Eycon and T800 instruments use the LOGDEV block in their LIN databases to configure recorded values into .uhh
files. If LINtools is upgraded, and if the existing LOGDEV block (prior to version 3.0) is then deleted and a new
LOGDEV block (version 3.0 or higher) is created, then Review will not be able to associate the data from the new
block with that created using the old block.
This is because, prior to version 3.0, tag identifiers were of the format: <Tag><Descriptor><chan type><chan
number>, but tag identifiers for later versions are of the format <Descriptor><BlockRef>.
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13 Other items
13.1 InSQL format
This format contains three header lines followed by all process variable (PV) values from the relevant uhh file.
Fields in lines are separated by commas.
Header

Values
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Line

Field

Contents

Description

1

0

ASCII

File format

2

0

|

Field delimiter

3

0

Review

User name (fixed string)

1

1

Time format (=1 = local time)

2

Server local

3

1

4

1

Indicates that time stamps are in the local
timezone of the server (assumed to be the same
zone as the instrument).
Default behaviour if a missing block is
encountered. 1 = create replacement blocks
Create history blocks necessary to import data

0

instrumentname.Tagname or
Tagname

1

1

Either: Instrument name and channel descriptor
from the uhh file, converted to ASCII strings and
separated by a dot, or
Tagname only, depending on options fitted.
Type of operation (insert)

2

YYYY/MM/DD

Date of the sample

3

HH:MM:SS.MSEC

Local instrument time of sample

4….n

4

Empty

5

Empty

6

0

Indicates that the value is in engineering units

7

nn.nn

8

192 or other value

Sample value in the format as displayed at the
instrument. The decimal separator is that
configured in the PC. If the ‘OPC Quality’ (below)
is not ‘Good’, this value is 0.
OPC
Uhh status
Quality name
Quality
192
Good
Good
28
PV OFF
Out of service
32
Ranging or
Waiting for initial
No Data
data
16
Over Range or
Sensor failure
Under Range
12
Hardware error
Device failure

4

Hardware
exceeded or
Too many lin.
tables

Config error

0

PV Overflow or
Bad PV

Bad
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13.2 Log Group contents restrictions
The number of points that can be read from a log group in an archive group is limited to 127. Only those points
up to the limit are transferred; any further points are ignored.

13.3 Batch phases
For those instruments which support the feature, a phase represents a specific part of a batch, such as Heat, Cool,
Rinse etc. entered as a part of the batch configuration.
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Copy to File ............................................................................ 39
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Copy To... ............................................................................... 50

Add Instrument ....................................................................... 68
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Data Bits ................................................................................. 58
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Database Selection................................................................... 8

Annotation timestamp ............................................................. 77

Database size ........................................................................... 1
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Database size reduction ........................................................... 9
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Database too big....................................................................... 9

Archive/Delete data older than ................................................ 34

DATABASE TRANSFER ........................................................ 25

Archiving on during backup ..................................................... 64

Date and time of printing ......................................................... 46

Archiving On during Copy ....................................................... 59

Date/Time Format ................................................................... 38

Arrange Files .......................................................................... 56

Date/Time windows .................................................................. 3

Auto Archive ........................................................................... 34

Default Chart mode................................................................. 87

Auto Backup + Transfer .......................................................... 61

Default Chart setup ................................................................. 87

Auto Zone ............................................................................... 19

Default CSV format ................................................................. 87

AUTOMATE ............................................................................ 26

Default database................................................................. 8, 30

AUTOMATE area.................................................................... 66

Default Separator.................................................................... 87

Automatic Instrument tag... ..................................................... 26

Default Spreadsheet and Export data ..................................... 87

Automatic print ........................................................................ 28

Default Trace Mode ................................................................ 87

Average mode ........................................................................ 14

Delete ............................................................................... 29, 49

Background Area .................................................................... 62

Delete files from instrument after backup ................................ 64

BACKUP area ......................................................................... 64

Delete old data from database ................................................ 34

Backup enabled ...................................................................... 64

Deleting Batches..................................................................... 30

Backup files to transfer ........................................................... 65

Deleting points ........................................................................ 13

Basic Concepts ......................................................................... 2

Destination.............................................................................. 64

Batch ................................................................................ 41, 75

Details .................................................................................... 56

Batch Name ...................................................................... 41, 46

Dialogue box........................................................................... 62

Batch search........................................................................... 75

Duration .................................................................................. 42

Batch selection ....................................................................... 75

Duration boxes.................................................................. 73, 74

Baud Rate............................................................................... 58

Edit ......................................................................................... 29

Calendar ................................................................................. 74

Edit Menu ............................................................................... 52

Cascade ................................................................................. 91

Editing points .......................................................................... 13

Chart + Replay.................................................................... 4, 16

Effectivity .................................................................................. 1

Chart font ................................................................................ 85

Enable Database Auto Archive ............................................... 34

Chart List ................................................................................ 92

Enable Review Full demo ....................................................... 90

Chart Menu ............................................................................. 71

Enable Security effects ........................................................... 83

Chart Setup ............................................................................ 17

Error messages ...................................................................... 93

Chart setup dialogue box ........................................................ 12

Exit ......................................................................................... 51

Close Chart............................................................................. 20

Export ..................................................................................... 36

Colour change ........................................................................ 14

Export Range .......................................................................... 36

Column widths ........................................................................ 44

EXPORT TO CSV FILE .................................................... 25, 65

Comm.log ............................................................................... 68

Export What? .......................................................................... 37

Comms Logging to instrument disk ......................................... 60

Faceplates ................................................................................ 3

Communications parameters .................................................. 58

File extension ......................................................................... 87

Compacting the Database....................................................... 30

File naming ............................................................................. 87

Connect timeout...................................................................... 68

File Services ........................................................................... 58

Copy ....................................................................................... 52

File Transfer ........................................................................... 27
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File Type ................................................................................. 59

Maximum mode ...................................................................... 14

Files to backup........................................................................ 64

Merge batches ........................................................................ 75

Find Batch ........................................................................ 37, 41

Merge batches with matching descriptors ......................... 29, 41

Find First................................................................................. 75

Minimum mode ....................................................................... 14

Find Next ................................................................................ 75

Move to Existing Archive Database ......................................... 33

Fit to ....................................................................................... 47

Move to New Archive Database .............................................. 33

Folder to store Archive Database in ........................................ 34

New Chart............................................................................... 12

Font Definition......................................................................... 85

New Database ........................................................................ 31

Fonts... ................................................................................... 85

New Window........................................................................... 91

Format of export data.............................................................. 36

Next Archive/delete due .......................................................... 34

From ....................................................................................... 42

Next run .................................................................................. 66

Go To... .................................................................................. 72

No User .................................................................................. 77

Grid Major Divisions ................................................................ 17

Normal mode .......................................................................... 14

Grid Minor Divisions ................................................................ 17

OK .......................................................................................... 63

Header/Footer......................................................................... 46

Only batches active after start of ............................................. 36

Header/Footer font .................................................................. 85

Only batches active before end of ........................................... 36

Help Menu .............................................................................. 93

Open Chart ............................................................................. 20

Hide data from other batches/phases................................ 41, 75

Options Menu ......................................................................... 84

Hide Data from other batches/phases ..................................... 37

Page Layout ........................................................................... 46

Horizontal scroll bar .................................................................. 3

Page number .......................................................................... 46

Identifier .................................................................................. 68

Page Setup ....................................................................... 44, 48

Include Column Headers................................................... 38, 87

Page x of y.............................................................................. 46

InSQL file names .................................................................... 87

Paper size............................................................................... 48

InSQL Format ................................................................... 38, 87

Parity ...................................................................................... 58

Instrument............................................................................... 77

Password .......................................................................... 58, 62

Instrument access ................................................................... 58

Pause Replay ........................................................................... 4

Instrument list ......................................................................... 63

PC Setup

Instrument menu ..................................................................... 57

Run as service .................................................................... 70

Instrument Name .................................................................... 59

PDF copies of charts............................................................... 29

Instrument Password .............................................................. 63

PDF printer drivers .................................................................. 29

Instrument tag if not configured in the instrument .................... 65

Perform Archive/Delete every ................................................. 34

Instrument User Name ...................................................... 61, 63

Phase ......................................................................... 37, 41, 75

Interpolation off ....................................................................... 14

Point Properties ................................................................ 13, 14

Interpolation on ....................................................................... 14

Points Included ....................................................................... 13

Invert All............................................................................ 60, 63

Preparing files for transfer ....................................................... 26

Invert Selection ....................................................................... 52

Preview................................................................................... 45

Keep traces clear of timestamps ............................................. 17

Print .................................................................................. 40, 45

Large font ............................................................................... 85

Print entire batch/phase .......................................................... 41

Last Refresh ........................................................................... 59

Print Output ............................................................................ 44

Layout ............................................................................... 38, 44
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